Physical Property Measurement System®

DynaCool™ User’s Manual

Part Number 1307-110, D1
Quantum Design, Inc.
10307 Pacific Center Court
San Diego, CA 92121-4340
USA

Technical support  (858) 481-4400
(800) 289-6996
Fax  (858) 481-7410


Trademarks
Two-tau model™ is a trademark of Quantum Design. Other product and company names appearing in this manual are trademarks or registered trademarks of their respective holders.

U.S. Patents
5,311,125  Magnetic Property Characterization System Employing a Single Sensing Coil Arrangement to Measure AC Susceptibility and DC Moment of a Sample (patent licensed from Lakeshore)
5,798,641  Torque Magnetometer Utilizing Integrated Piezoresistive Levers

Other Patents Pending
## Table of Contents

### PREFACE

- Contents, Conventions, and Safety .......................................................... xi

### CHAPTER 1

#### Getting Started ...................................................................................... 1-1

1.1 Overview ............................................................................................... 1-1

1.2 Introduction to PPMS DynaCool .......................................................... 1-1

1.3 How to use this Manual ........................................................................ 1-2

1.4 Quick Start: System Startup and Cool Down ...................................... 1-3

1.4.1 Turn on Power to Electronics ......................................................... 1-3

1.4.2 Check Cooling Water and Power to Compressor ....................... 1-3

1.4.3 Check Helium Bottle ..................................................................... 1-3

1.4.4 Launch Startup Procedure ............................................................. 1-3

1.4.5 Wait for Cool Down ...................................................................... 1-4

1.4.6 Shutting Down the System and Other Tasks ............................. 1-4

1.4.7 Temperature, Field, and Chamber Commands ......................... 1-4

1.5 Installing and Removing Samples ...................................................... 1-5

1.5.1 The “Puck” ................................................................................ 1-5

1.5.2 Installing a Sample Puck .............................................................. 1-5

1.5.3 Removing a Sample Puck ............................................................. 1-8

1.6 Configure Measurement Option and Perform Measurement .......... 1-9

### CHAPTER 2

#### Hardware ............................................................................................... 2-1

2.1 Overview ............................................................................................... 2-1

2.2 System Hardware Components .......................................................... 2-1

2.2.1 Cryostat Assembly .................................................................... 2-2

2.2.2 CAN Module Bay ....................................................................... 2-3

2.2.2.1 CAN Power Supply and Power Distribution ....................... 2-4

2.2.2.2 CAN Network Controller and Distribution ..................... 2-5

2.2.2.3 Magnet Signal Distribution ................................................. 2-5

2.2.3 Pump Cabinet and Computer ...................................................... 2-6

2.2.3.1 Gas Handling Connections ............................................... 2-7

2.2.3.2 Back Panel and Cabinet Bays ............................................. 2-8

2.2.4 Cryocooler Compressor Assembly ......................................... 2-10

2.2.5 Helium Gas Bottle and Regulator ............................................. 2-11

2.3 Measurement System Hardware ...................................................... 2-11

2.3.1 Sample Pucks ............................................................................ 2-11

2.3.2 Puck-Insertion Tool ................................................................. 2-12
CHAPTER 3
Software.................................................................................................................. 3-1
3.1 Overview ............................................................................................................. 3-1
3.2 MultiVu .................................................................................................................. 3-2
  3.2.1 Menu Bar ....................................................................................................... 3-3
  3.2.2 Tool Bar ......................................................................................................... 3-4
  3.2.3 Control Center ............................................................................................... 3-4
  3.2.4 Sequence Command Bar ................................................................................ 3-4
  3.2.5 Status Bar ....................................................................................................... 3-5
  3.2.6 Sequence Window ......................................................................................... 3-5
  3.2.7 Data Windows: Graph, Record, and Table Views ........................................ 3-6
  3.2.8 Cryostat Monitor Dialog .............................................................................. 3-6
    3.2.8.1 Status Information ................................................................................... 3-7
    3.2.8.2 Cryostat Control Tasks ........................................................................... 3-7
  3.2.9 Instrument Utility Tools ................................................................................ 3-8
  3.3 Measurement Options ....................................................................................... 3-9
  3.4 Sequences ............................................................................................................ 3-10
    3.4.1 Editing Sequences ....................................................................................... 3-11
    3.4.2 Advanced Script Editing ............................................................................. 3-12
    3.4.3 Running Sequences ..................................................................................... 3-12
    3.4.4 Locking Sequence Execution ....................................................................... 3-13
    3.4.5 Sequence Commands .................................................................................. 3-13
      3.4.5.1 System Commands ............................................................................... 3-13
      3.4.5.2 Measurement Commands .................................................................... 3-16
  3.5 Graphing Data Files ............................................................................................ 3-16
    3.5.1 Data Selection and Plot Axes ...................................................................... 3-16
    3.5.2 Plot Appearance ........................................................................................... 3-17
    3.5.3 Template and Graph Files .......................................................................... 3-18
    3.5.4 Exporting Data Files ................................................................................... 3-19
  3.6 Temperature, Magnet, and Cryostat Services ................................................... 3-20

CHAPTER 4
Theory of Operation .................................................................................................... 4-1
4.1 Overview .............................................................................................................. 4-1
4.2 Cryostat Control System ..................................................................................... 4-1
  4.2.1 Pulse Tube Cryocooler .................................................................................. 4-3
  4.2.2 Thermal Isolation ........................................................................................... 4-3
  4.2.3 Monitoring and Control ................................................................................ 4-4
  4.2.4 Startup Operation ........................................................................................... 4-5
  4.3 Chamber Temperature Control System ............................................................. 4-5
    4.3.1 Sample Chamber Thermometers and Heaters ............................................ 4-5
    4.3.2 Helium Flow and Circulation Loop ............................................................. 4-6
      4.3.2.1 Loop Purge During System Startup ..................................................... 4-7
      4.3.2.2 Main Flow ............................................................................................. 4-7
      4.3.2.3 Low Temperature Flow ....................................................................... 4-7
    4.3.3 Temperature Control Electronics and Software .......................................... 4-8
4.3.4 Temperature Values and Configurations ................................................. 4-8
4.3.4.1 Temperature Values Reported in Software and Data Files ....................... 4-8
4.3.4.2 Temperature Control Configurations .................................................. 4-9
4.4 Magnetic Field Control System ............................................................... 4-12
4.4.1 Magnet and Leads .................................................................................. 4-12
4.4.2 Magnet Controller and Software ............................................................ 4-12
4.4.3 Magnetic Shielding ............................................................................... 4-13
4.4.4 Magnetic Field Accuracy, Uniformity, and Magnet Reset .......................... 4-13
4.5 Chamber Atmosphere Control System ...................................................... 4-13
4.5.1 Chamber Operations ........................................................................... 4-15
4.6 Case Vacuum System .............................................................................. 4-16
4.6.1 Case Vacuum Operation ....................................................................... 4-16

CHAPTER 5
Maintenance and Servicing ..................................................................... 5-1
5.1 Overview ................................................................................................. 5-1
5.2 Changing the Helium Gas Supply Cylinder ............................................... 5-1
5.3 Replacing the Scroll Pump tip Seals (Varian SH110) Scroll Pump .............. 5-3
5.3.1 Replacing the Tip Seals on a Cold System ............................................. 5-4
5.3.2 Replacing the Tip Seals on a Warm System ........................................... 5-4
5.4 Inspecting and Maintaining O-rings ......................................................... 5-5
5.5 Replacing Fuses and Resetting Breakers ................................................. 5-6
5.5.1 Pump Cabinet Power Input Breakers ..................................................... 5-6
5.5.2 Pump Cabinet External 24 V Breakers .................................................. 5-6
5.5.3 Cryostat Controller Board Fuses ........................................................... 5-7
5.5.4 Magnet Controller Fuses and Breakers ................................................. 5-7
5.5.5 CAN Module Bay Fuses ....................................................................... 5-7
5.6 Shutting Down the DynaCool System ...................................................... 5-8
5.7 Starting up a Cold DynaCool System ....................................................... 5-8
5.8 Compressor Adsorber Replacement ......................................................... 5-8
5.9 Cleaning .................................................................................................. 5-8
5.10 Required Maintenance Log .................................................................... 5-9

APPENDIX A
System Setup ............................................................................................. A-1
A.1 Overview ................................................................................................ A-1
A.2 Site Requirements .................................................................................. A-1
A.3 Initial Installation .................................................................................... A-2
A.3.1 Unpack the Cryostat Crate ................................................................. A-2
A.3.2 Unpack the Cabinet Crate ................................................................. A-3
A.3.3 Unpack and Inspect Fittings ............................................................... A-3
A.3.4 Connect Magnet Controller ............................................................... A-3
A.3.5 Make Cabinet Connections ............................................................... A-3
A.3.6 Mount and Connect the CAN Module Bay ........................................... A-4
A.3.7 Install Helium Gas Regulator ............................................................. A-4
A.3.8 Make Compressor Connections ......................................................... A-4
A.3.9 Power up the System ......................................................................... A-5
A.3.10 Attach Deck and Cryostat Cover ....................................................... A-5

APPENDIX B
# Table of Contents

## Diagnostic Software

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.1</td>
<td>Overview</td>
<td>B-1</td>
</tr>
<tr>
<td>B.2</td>
<td>Log Data</td>
<td>B-1</td>
</tr>
<tr>
<td>B.2.1</td>
<td>Standard Items</td>
<td>B-2</td>
</tr>
<tr>
<td>B.2.2</td>
<td>Diagnostic Items</td>
<td>B-3</td>
</tr>
<tr>
<td>B.2.3</td>
<td>Advanced Items</td>
<td>B-3</td>
</tr>
<tr>
<td>B.3</td>
<td>Background Log</td>
<td>B-3</td>
</tr>
<tr>
<td>B.4</td>
<td>Event and Error Logging</td>
<td>B-4</td>
</tr>
<tr>
<td>B.4.1</td>
<td>MultiVu Event Log</td>
<td>B-4</td>
</tr>
<tr>
<td>B.4.2</td>
<td>Temperature, Magnet, and Cryostat Service Logs</td>
<td>B-4</td>
</tr>
<tr>
<td>B.4.3</td>
<td>Option Log Files</td>
<td>B-4</td>
</tr>
</tbody>
</table>

## Appendix C

Pin-out and Interconnect Diagrams

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>C.1</td>
<td>Overview</td>
<td>C-1</td>
</tr>
<tr>
<td>C.2</td>
<td>System Interconnects</td>
<td>C-1</td>
</tr>
<tr>
<td>C.3</td>
<td>Sample Puck Connections (Gray Lemo and JQP-8)</td>
<td>C-6</td>
</tr>
<tr>
<td>C.4</td>
<td>Temperature Control (JQP-9 and JG-1)</td>
<td>C-7</td>
</tr>
<tr>
<td>C.5</td>
<td>Cryostat Temperature Control (JQP-7 JQQ-2)</td>
<td>C-9</td>
</tr>
<tr>
<td>C.6</td>
<td>Cryostat Gas Control (JQQ-6)</td>
<td>C-10</td>
</tr>
<tr>
<td>C.7</td>
<td>Magnet Signals (JQP-4, JQR-6, JQR-7, JQR-8 and JQB-1/JQS-1)</td>
<td>C-12</td>
</tr>
<tr>
<td>C.8</td>
<td>QD CAN Connectors</td>
<td>C-13</td>
</tr>
<tr>
<td>C.9</td>
<td>Storage of Calibration Information (SROMs)</td>
<td>C-14</td>
</tr>
</tbody>
</table>

## Appendix D

Using Third-party Instruments

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>D.1</td>
<td>Overview</td>
<td>D-1</td>
</tr>
<tr>
<td>D.2</td>
<td>WinWrap® Visual Basic Scripting in MultiVu</td>
<td>D-1</td>
</tr>
<tr>
<td>D.3</td>
<td>National Instruments LabVIEW®</td>
<td>D-2</td>
</tr>
<tr>
<td>D.4</td>
<td>Object Linking and Embedding (ActiveX)</td>
<td>D-2</td>
</tr>
</tbody>
</table>
Figures

Figure 1-1. Photo of the Computer, Pump Cabinet, and Cryostat........................................... 1-1
Figure 1-2. Cryostat monitor status panel showing "Cold" cryostat........................................... 1-4
Figure 1-3. Example of a puck................................................................................................. 1-5
Figure 1-4. Operation of puck insertion tool............................................................................ 1-6
Figure 1-5. Puck insertion tool connecting to puck ................................................................. 1-6

Figure 2-1. Front view of cryostat ............................................................................................ 2-2
Figure 2-2. Back base of cryostat ............................................................................................ 2-3
Figure 2-3. CAN Module Bay and sample puck wiring port (gray Lemo)................................. 2-3
Figure 2-4. CAN Module Bay back panel ............................................................................... 2-4
Figure 2-5. Front view of Pump Cabinet ................................................................................... 2-6
Figure 2-6. Back view of Pump Cabinet. Left view is 9T system and right view is a 14T system... 2-8
Figure 2-7. Connectors to the Cryostat Controller electronics on the back of the Pump Cabinet 2-9
Figure 2-8. Helium Compressor ............................................................................................. 2-10
Figure 2-9. Helium gas bottle with regulator............................................................................ 2-11
Figure 2-10. Top and bottom views of a sample puck.............................................................. 2-12
Figure 2-11. Insertion Tool with Lever in Engaged Position....................................................... 2-12
Figure 2-12. Cross-section of Sample Chamber Access Port and Baffle Set.............................. 2-13
Figure 2-13. Puck Adjustment Tool........................................................................................ 2-15
Figure 2-14. Puck Wiring Test Station ...................................................................................... 2-16
Figure 2-15. Typical CAN module with Front panel (right)...................................................... 2-17
Figure 2-16. Rear panel of a typical CAN module .................................................................. 2-17

Figure 3-1. Overview of software applications running on PC.................................................. 3-1
Figure 3-2. MultiVu Main Window.......................................................................................... 3-2
Figure 3-3. Main Menu Bar.................................................................................................... 3-3
Figure 3-4. Tool Bar................................................................................................................ 3-4
Figure 3-5. Sequence Control Center...................................................................................... 3-4
Figure 3-6. Sequence Command Bar ...................................................................................... 3-5
Figure 3-7. MultiVu DynaCool Status Bar & Panels................................................................. 3-5
Figure 3-8. Cryostat Monitor................................................................................................... 3-6
Figure 3-9. VSM Option's Control Centers............................................................................. 3-10
Figure 3-10. Disabling Sequence Commands......................................................................... 3-11
Figure 3-11. Sample Chamber Atmosphere Control Center................................................... 3-13
Figure 3-12. Graph Data Selection Dialog (on graph; right-click to Data Selection)................ 3-17
Figure 3-13. Plot appearance dialog ...................................................................................... 3-18
Figure 3-14. Exporting Data .................................................................................................. 3-19
Figure 3-15. DynaCool Services Control Dialog.................................................................... 3-20

Figure 4-1. The DynaCool Cryostat showing the components of the Cryostat Control System, Chamber Temperature Control System, and Magnetic Field Control System......................................................... 4-2
Figure 4-2. The DynaCool Cryostat showing components of the Chamber Atmosphere Control System and Case Vacuum System ............................................................................................................ 4-14

Figure 5-1. Helium gas supply cylinder and regulator............................................................... 5-2
Figure 5-2. Check-valve assembly for purging air from the regulator of the helium gas supply cylinder .......................................................... 5-2
Figure 5-3. Pump exhaust filter assembly .............................................................................. 5-3
## Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-1</td>
<td>Floor Space Requirement for Pump Cabinet and Cryostat</td>
<td>A-1</td>
</tr>
<tr>
<td>B-2</td>
<td>Data Logging Interface</td>
<td>B-2</td>
</tr>
<tr>
<td>B-3</td>
<td>Standard Items Tab</td>
<td>B-3</td>
</tr>
<tr>
<td>C-2</td>
<td>DynaCool System Interconnects for 9 T System</td>
<td>C-2</td>
</tr>
<tr>
<td>C-3</td>
<td>DynaCool System Interconnects for 14 T System</td>
<td>C-3</td>
</tr>
<tr>
<td>C-4</td>
<td>DynaCool Power Distribution for 9 T System</td>
<td>C-4</td>
</tr>
<tr>
<td>C-5</td>
<td>DynaCool Power Distribution for 14 T System</td>
<td>C-5</td>
</tr>
<tr>
<td>C-6</td>
<td>Sample connections: a) Sample puck, b) Gray Lemo connector, c) JQP-8 Sample D-shell connector</td>
<td>C-6</td>
</tr>
<tr>
<td>C-7</td>
<td>Temperature control connections: a) JG-1 connector, b) JQP-9 connector</td>
<td>C-7</td>
</tr>
<tr>
<td>C-9</td>
<td>Cryostat temperature control connections: a) JQP-7 connector, b) JQQ-2 connector</td>
<td>C-9</td>
</tr>
<tr>
<td>C-11</td>
<td>Cryostat gas control connections: a) JQQ-6 connector, b) Mass Flow Controller connector, c) High Vacuum Valve connector, d) JQP-10 Solenoid Valve connector</td>
<td>C-11</td>
</tr>
<tr>
<td>C-12</td>
<td>Magnet Signals (JQP-4, JQR-6, JQR-7, JQR-8 and JQB-1/JQS-1)</td>
<td>C-12</td>
</tr>
<tr>
<td>C-13</td>
<td>QC CAN connectors: a) Male QD CAN connector, b) Female QD CAN connector</td>
<td>C-13</td>
</tr>
</tbody>
</table>
# Tables

Table 5-1. Maintenance procedures required for the DynaCool system ................................................................. 5-9

Table C-1. Sample Puck Connections .................................................................................................................. C-6
Table C-2. JQP-9 and JG-1 Temperature Control Connections ........................................................................ C-8
Table C-3. JQP-7 and JQQ-2 Cryostat Temperature Control .............................................................................. C-10
Table C-4. JQQ-6 Cryostat Gas Control ................................................................................................................ C-11
Table C-5. Magnet Signals ................................................................................................................................... C-12
Table C-6. QC CAN connectors ......................................................................................................................... C-13
Table C-7. DynaCool base system SROMs ........................................................................................................ C-15
Contents, Conventions, and Safety

P.1 Overview

The preface describes the scope of the manual, the conventions used, and most importantly, safety guidelines.

P.2 Scope of the Manual

This manual discusses the Quantum Design PPMS DynaCool instrument. It contains information about basic functionality, describes the system hardware, and the control software.

Most DynaCool systems include measurement options that you use for performing sample measurements. This manual discusses how measurement options interface with DynaCool, but does not cover any details about specific options. Be sure to read the separate measurement option user manuals.

All DynaCool systems include a cryocooler system, which consists of a cold head and a compressor manufactured by Cryomech, Inc. Be sure to read the Cryomech User Manual.

P.3 Conventions in the Manual

![Warning Symbol]

This symbol signals specific caution or conditions that could result in system damage, bodily harm, or loss of life.

![Electrical Hazard Symbol]

This symbol signals electrical hazards that could result in bodily harm, or loss of life. Used at all accessible 200-230 V power outlets.
P.4 Safety Guidelines and Regulatory Information

Before using this product, please read the entire content of this manual and observe all instructions, warnings and cautions. These are provided to help you understand how to safely and properly use DynaCool.

Quantum Design Inc. disclaims any liability for damage to the system or injury resulting from misuse or improper operation of the system. Please contact your Quantum Design representative for any service issues.

This product is NOT user serviceable except for the operations that are described as performable by the user in Chapter 5.

Observe the following safety guidelines when you use your system:

- In case of emergency, switch off the breaker on the back of the pump cabinet labeled “MAIN PWR” (see Figure 2-6) and the main breaker on the compressor (see Figure 2-8).
- To prevent electrical shock, disconnect the system from power before you install it, adjust it, or service it.
- The instrument must be plugged into or permanently connected to a 200-230 VAC 50/60HZ branch circuit protected by a 30 A breaker.
- For continued protection against fire hazard, electric shock and irreversible system damage, replace fuses only with same type and rating of fuses for selected line voltage. Information about user-accessible fuses and their replacement is summarized in Section 5.6.
- Keep this system away from radiators and heat sources. Provide adequate ventilation to allow for air cooling around the instrument and compressor.
  - Do not obstruct the ventilation openings in the front and back of the pump cabinet. The ventilation openings in the front of the cabinet face down and are located between the light gray and dark gray sections.
  - Do not obstruct the ventilation openings on the left side of the CAN module bay.
- Take care not to damage the high pressure helium gas lines, which contain helium at approximately 2 MPa (300 psi). Do not bend the lines tighter than 30 cm (12 inches) radius. Do not damage the lines with sharp objects, and do not place any objects on top of the lines. Damage to these lines could cause sudden release of high pressure gas.
- If this system is used in a way not specified by Quantum Design, then the protection provided by the equipment may be impaired.
C H A P T E R  1

Getting Started

1.1  Overview

This chapter provides a brief introduction to DynaCool and describes how to perform some common tasks. Be sure to read the rest of the manual to become familiar with the details of the system.

1.2  Introduction to PPMS DynaCool

The Quantum Design DynaCool is an instrument designed to measure a variety of a sample’s physical properties while controlling the conditions experienced by the sample.

The Quantum Design DynaCool is a next generation Physical Property Measurement System (PPMS). The PPMS DynaCool is a completely redesigned instrument that provides all the capabilities of the
PPMS without the need for any liquid cryogens. The system uses a single two-stage pulse tube cooler to cool both the superconducting magnet and the temperature control system, providing a low vibration environment for sample measurements.

The PPMS DynaCool employs a minimum amount of condensed liquid Helium-4 for cooling both the sample chamber and superconducting magnet. As a result, the system requires only a small volume of bottled helium gas for its fully automated startup and operation. The PPMS DynaCool also comes standard with an integrated cryopump used to pump out the sample space to a vacuum of \(< 10^{-4}\) Torr. This makes the PPMS DynaCool compatible with all existing Quantum Design cryogenic hardware, or any other user-designed experiments.

For temperature control, DynaCool uses a novel gas flow regulation system to improve both cooling power and temperature stability as compared to the already state-of-the-art PPMS temperature control. Along with sophisticated control software, this system provides seamless transitions between high temperatures (400 K) with minimal cooling power needs, intermediate temperatures with rapid slewing and large cooling needs, and stable operation near the base temperature (\(< 1.8\) K) with cooling provided by evaporating liquid helium. With this new control system PPMS DynaCool is capable of cooling a standard PPMS sample puck from 300 K to 1.9 K, stable, in less than 40 minutes. The sample chamber design has also been improved for better thermal uniformity at both low and high temperatures while maintaining the robust 12-pin sample puck interface from the original PPMS. Multiple thermometers and heaters manage temperature gradients and ensure smooth temperature control throughout the accessible temperature range.

The PPMS DynaCool comes with a built in cryopump and vacuum gauge for controlling the sample environment. The cryopump can pump out the sample chamber to less than \(10^{-4}\) Torr in under 10 minutes. This feature is fully integrated allowing you to change the chamber environment during a programmed sequence or script.

The PPMS DynaCool comes equipped with either a 9 T or 14 T conduction cooled superconducting switch-less magnet system. This system includes a hybrid digital/analog magnet controller, designed for precise, quiet control of the magnetic field. The bipolar design also allows smooth continuous ramping through zero field. Magnet control software monitors the temperature of the magnet and cryostat at 3 locations to ensure proper operation of the magnet system and avoid time consuming quenches.

The PPMS DynaCool has a built in magnetic shield. For a system with a 9 T magnet, this shield maintains the 5 gauss line \(<30\) cm the surface of the cryostat cabinet allowing the system to be installed closer to other sensitive instruments for better lab space utilization.

### 1.3 How to use this Manual

This user manual is organized from front to back with broad review of features in the front and in-depth description of details toward the back. If you are familiar with PPMS-type systems, the first chapter may be all you need to get started with measurements. However, all users should read the first 3 chapters of this manual for proper working knowledge of the basic system features. Chapter 4 contains an in-depth description of the theory of operation. Chapter 5 covers routine maintenance and servicing procedures.
1.4 Quick Start: System Startup and Cool Down

This section covers cooling down the cryostat from a completely warm state to normal operating temperature. If your DynaCool system has not been fully installed in your lab, please refer to Appendix A: “System Setup” for instructions.

1.4.1 Turn on Power to Electronics

Make sure all the breakers on the back of the cabinet are turned on and the computer is booted up. MultiVu should be running.

- Make sure the breakers in the back of the cabinet are turned on. The power light on the back of the cabinet should be lit.
- Make sure the power switch on the back of the CAN Module Bay is set to on. The PWR indicator should be illuminated on the temperature control module in the CAN Module Bay.
- Make sure the computer is on. Observe that the PWR light from the USB-based CAN Network transceiver is lit. This is located in the back of the CAN module bay.

1.4.2 Check Cooling Water and Power to Compressor

Make sure the chilled cooling water is flowing through the compressor and that the circuit breaker is switched to the ON position. DO NOT press the green start button.

1.4.3 Check Helium Bottle

Make sure the needle valve is open on the helium supply bottle and that the bottle pressure is at least 300 psi (2 MPa) before proceeding. For a standard K-size cylinder, this ensures that the helium supply is adequate for the startup procedure.

1.4.4 Launch Startup Procedure

Follow the steps below to begin the cool down procedure:

1. Launch the MultiVu software. Verify that there are no red indicators in the status bar at the bottom of the MultiVu window. If there are any messages indicating that a service is stopped, then start the services by double-clicking the DynaCool Services Control icon in the lower right of the screen and pressing Start All Services from the DynaCool Services Window.

2. Open the Cryostat Monitor from the “Instrument > Cryostat…” menu item and press the “Startup…” button on the left and follow the brief instructions to begin the startup procedure.
1.4.5 Wait for Cool Down

After the startup procedure has been launched, you can close the Cryostat Monitor window, or leave it open to track the progress of the cool down. A typical cool down time for a 9 T DynaCool is about 16 hours. During this time, the system performs several operations; including:

- Purge the cryostat vacuum space with air to flush out any residual helium gas.
- Evacuate the cryostat vacuum space.
- Purge and fill the circulation loop with a clean charge of helium from the bottle.
- Regenerate the chamber cryopump.
- Start the cryocooler compressor and cool the system to its base temperature of about 4 K.
- Condense 100 to 200 cc of liquid helium into the cooler reservoir.

Upon completion of the startup procedure, the Cryostat Monitor status will read “Cold Cryostat” and the Cryostat Status panel will indicate “Cold”:

![Figure 1-2. Cryostat monitor status panel showing “Cold” cryostat.](image)

1.4.6 Shutting Down the System and Other Tasks

It may be necessary to shut the system down from time to time or perform system-level control tasks. Please refer to Chapter 3, Section 3.2.8 “Cryostat Monitor Dialog” for a description of the shutdown and other cryostat commands.

1.4.7 Temperature, Field, and Chamber Commands

With the system now ready to be used, you can perform various control tasks immediately.

- To set temperature, select the “Instrument > Temperature…” menu item, enter a Set Point of 300 K and a Rate of 20 K/min, and click “Set” to bring the sample chamber to room temperature.
- To set magnetic field, select the “Instrument > Field…” menu item, then enter a Set Point of 10000 Oe, and a Rate of 200 Oe/sec, and click “Set” to bring magnetic field to 1 Tesla.
Once the sample chamber is stable at room-temperature, select “Instrument > Chamber…”, and click “Vent and Seal” to vent up the chamber with helium gas. You can then remove the KF flange cover at the top of the cryostat to open the sample chamber. After closing the sample chamber you can click “Purge/Seal” to vent and flush the chamber with helium gas from the bottle.

Note that you can also bring up these instrument control dialogs by clicking on the corresponding panel in the status bar at the bottom of the DynaCool MultiVu window.

### 1.5 Installing and Removing Samples

#### 1.5.1 The “Puck”

Sample mounting varies widely depending on the type of measurement you perform. You should consult the appropriate measurement option manual for information about sample mounting methods. However, for most measurement options the sample holder is some variation on the basic PPMS “puck” design:

![Figure 1-3. Example of a puck.](image)

When installed into the DynaCool sample chamber, this puck provides the sample with both electrical and thermal contact to the chamber.

#### 1.5.2 Installing a Sample Puck

A puck that you are installing in the sample chamber may have your sample mounted on it, or it may have measurement hardware on it, e.g. VSM coil set. Either way, use the following procedure to install a puck. For a puck with a sample on it, you should use the measurement option sample installation wizard to walk you through this process, because the wizard also guides you through other important tasks such as setting up a data file. The measurement option will not give you detailed instructions on use of the puck insertion tool, so be sure to read these instructions first.
1. Disengage the sample insertion tool by flipping up the black switch located on top of the tool or by fully depressing the switch.

**WARNING!**
The part of the puck-insertion tool shown at the bottom of Figure 1-5 is very fragile. Even a smallest dent in this rim will prevent it from properly engaging a puck.

![Figure 1-4. Operation of puck insertion tool.](image)

2. Insert the puck, with the sample facing upward, inside the hollow cylinder that is at the bottom of the sample insertion tool. The sample will be inside the cylinder and the connectors and solder pads will be outside the cylinder.

![Figure 1-5. Puck insertion tool connecting to puck.](image)
3. Rotate the puck to verify that it is properly seated inside the hollow cylinder. The puck should rotate smoothly.

4. Engage the sample insertion tool by flipping down the black switch located on top of the tool or by releasing the switch, if it is fully depressed, so that the switch lies flat across the tool’s handle. The tool should now grip the outer rim of the puck.

5. Verify that the puck remains properly seated in the hollow cylinder. The puck must be level, and should not rotate easily. Gently pull on the puck to verify that the tool holds it securely.

**WARNING!**

An unlevel puck can get stuck in the sample chamber and can damage the pins at the bottom of the chamber. Before inserting the puck into the chamber, you must verify that the puck is level within the cylinder of the sample insertion tool.

6. Verify that the sample chamber is at or above 298 K. The temperature must be at least 298 K to prevent condensation of water or cryopumping of air into the chamber. If the temperature is below 298 K, set it to 298 K and wait for the chamber to warm up. Use MultiVu to set the temperature: click on the temperature display in the status bar. In the temperature dialog, enter 298 K, 20 K/min, and select Fast Settle mode. Press the Set button. An installation wizard in measurement option software may set the temperature for you.

**WARNING!**

Do not open the sample chamber if it is below room temperature. Doing so may condense water and air in the sample chamber. Such contaminants may form a plug in the chamber resulting in dangerous and damaging over pressure condition on warming.

7. Verify that the magnetic field is less than 1 T (10,000 Oe). If the magnetic field is greater than 1 T, set zero field and wait for the field to stabilize before continuing. Use MultiVu to set the field: click on the field display in the status bar. In the field dialog, set 0 Oe, 200 Oe/sec, and select Linear approach. Press the set key.

**WARNING!**

If you place the sample insertion tool into the sample chamber when the magnet is at high field, the insertion tool will be strongly pulled into the sample chamber. The force may overwhelm you and cause damage to the instrument.

8. Vent the sample chamber with helium. Use MultiVu: click on the chamber atmosphere display in the status bar (this display shows the pressure and chamber state.) Press the “Vent Cont.” button in order to vent the chamber continuously. Do not leave the chamber in this state for longer than necessary, because doing so wastes vent gas from the bottle you supply. An installation wizard may vent the chamber for you.

9. Open the hinge clamp and remove the KF blank flange (and attached baffle set, if present) from the sample chamber access port. If the blank flange is difficult to move due to low pressure in the chamber, do not force it. Allow the pressure within the chamber to match the external pressure before you open the sample chamber to atmosphere.

10. Remove the O-ring from the sample chamber access port.
11. Gently lower the sample insertion tool into the sample chamber puck-end first until the sample puck touches the puck connector at the bottom of the chamber. Do not force the puck down farther once it touches the connector.

12. Rotate the sample insertion tool slowly until the key on the puck drops into the indexing notch. When the puck drops into the notch, you feel the puck lock into position.

13. Gently push down on the sample insertion tool in order to engage the puck interface and to make solid electrical contact between the interface and the puck.

**WARNING!**

Do not use excessive force when engaging the puck interface. The need for excessive force may indicate a problem, such as a misaligned puck. If you push hard you may bend the pins at the bottom of the sample chamber.

14. Disengage the sample insertion tool, and then raise the tool several centimeters. Be sure there is no resistance when you raise the insertion tool. Resistance indicates the puck may have gotten caught in the tool as you began lifting it out, and you may thus need to remove the puck and try inserting it again.

15. Remove the sample insertion tool from the sample chamber.

16. Check that the sample chamber access port KF flange, blanking flange, and O-ring are clean. Place the O-ring over the port, and replace the blank flange (with attached baffle set).

17. Place the flange clamp in position around the top of the sample chamber access port, and then latch the clamp.

18. Purge and seal the sample chamber using MultiVu: click on the chamber atmosphere display in the status bar. Press the Purge/Seal button in order to purge and seal the sample chamber. An installation wizard may do this for you.

The system is ready to begin an experiment. You should refer to the appropriate measurement option manual to determine what to do next. Once you perform a measurement and verify instrument operation, you may want to write a sequence to automate the measurement. See Section 3.4 for a discussion of sequences.

### 1.5.3 Removing a Sample Puck

The procedure for removing the puck from the sample chamber is essentially the reverse of the installation procedure. Complete the following steps to remove the puck:

1. Verify that the sample chamber is at or above 298 K. The temperature must be at least 298 K to prevent condensation of water or cryopumping of air into the chamber. If the temperature is below 298 K, set it to 298 K and wait for the chamber to warm up. An installation wizard in measurement option software will set the temperature for you.

**WARNING!**

Do not open the sample chamber if it is below room temperature. Doing so may condense water and air in the sample chamber. Such contaminants may form a plug in the chamber resulting in a dangerous over pressure condition on warming.
2. Verify that the magnetic field is less than 1 T (10,000 Oe). If the magnetic field is greater than 1 T, set zero field and wait for the field to stabilize before continuing.

**WARNING!**

If you place the sample insertion tool into the sample chamber when the magnet is at high field, the insertion tool will be strongly pulled into the sample chamber. The force may overwhelm you and cause damage to the instrument.

3. Vent the sample chamber with helium. An installation wizard may do this for you.
4. Open the hinge clamp and remove the KF blank flange (and attached baffle set, if present) from the sample chamber access port. If the blank flange is difficult to move due to low pressure in the chamber, do not force it. Allow the pressure within the chamber to match the external pressure before you open the sample chamber to atmosphere.
5. Remove the O-ring from the sample chamber access port.
6. Disengage the sample insertion tool by flipping up the black switch located on top of the tool or by fully depressing the switch. Refer to Figure 1-4.
7. Gently lower the sample insertion tool into the sample chamber cylinder-end first until the tool touches the bottom of the chamber.
8. Engage the sample insertion tool by flipping down the black switch located on top of the tool or by releasing the switch, if it is fully depressed, so that the switch lies flat across the tool’s handle. Refer to Figure 1-4.
9. Gently raise the insertion tool out of the sample chamber. You should feel some initial resistance as you pull the puck out of its seat.
10. Verify that the sample puck is in the insertion tool. If it is not, return to step 6. If it is, disengage the lever and let the puck fall safely into your hand. Do not drop the puck.

You may insert another puck, install measurement option hardware into the sample chamber, or close the sample chamber at this point. To close the sample chamber, you (1) place the O-ring and KF blank flange over the sample chamber access port, (2) place the flange clamp in position around the top of the chamber access port, (3) latch the clamp, and then (4) purge and seal the sample chamber.

### 1.6 Configure Measurement Option and Perform Measurement

Most measurements that you perform in DynaCool require the use of a measurement option, such as Vibrating Sample Magnetometer or Heat Capacity. Whenever you first start using an option, or when you change from using one option to another, follow the steps outlined below. Consult the relevant measurement option manual for details about the measurement option you are using.

1. If necessary, uninstall any hardware from a measurement option previously in use.
a. You always uninstall all option hardware from the sample chamber, including pucks, specialized baffle sets, and hardware attached to the chamber KF flange (e.g., VSM linear motor). Be sure the chamber is at room temperature, the magnetic field is zero, and the chamber is venting continuously before attempting to remove any option hardware.

b. It is not necessary to uninstall CAN modules unless you need extra space in the module bay.

2. Install hardware for the measurement option you are ready to use.
   a. For some options, you install pucks, specialized baffle sets, and hardware attached to the sample chamber. See the option manual for details. In general, you do not install samples, including pucks with samples on them, at this time.
   b. If necessary, install any CAN module(s) needed for the option into the module bay. The module(s) may already be installed from previous use of the option.

   ![WARNING!]

   You must turn off the power to the module bay using the switch on the back of the bay (see Chapter 2) whenever removing or installing CAN modules. “Hot plugging” can destroy the module.

3. Activate the option software. In MultiVu, select the menu item “Utilities > Activate Option…” You will be presented with a dialog showing available options. Select the desired option and press the “Activate -->” button. The option software will start within the MultiVu window, and will initialize the option hardware.

4. Install your sample. Use the measurement option installation wizard, because it guides you through all the necessary steps, including setting up data files and entering sample properties.

5. Perform an immediate mode measurement using the measurement option control panel in order to verify that everything is working correctly.

6. Write a sequence to automate the measurement. Execute the sequence, and allow the instrument to acquire data. See Section 3.4 for information about writing and executing sequences.

7. You can graph your measurement data while it is being acquired. To open the data file from an activated option, please see Section 3.5.

8. When the measurement sequence is complete, remove your sample using the option’s wizard. Then either install a new sample to measure, or go back to step 1 to use a different measurement option.
CHAPTER 2

Hardware

2.1 Overview

This chapter describes the DynaCool hardware and contains instructions for operating some hardware components. Be sure to read Chapter 1, Getting Started, before reading this chapter. For more information about how these components operate, see Chapter 4, Theory of Operation.

2.2 System Hardware Components

The PPMS DynaCool consists of the following main components:

- Cryostat Assembly
- CAN Module Bay
- Pump Cabinet and Computer
- Cryocooler Compressor Assembly
- Helium Gas Bottle and Regulator

The following sections provide additional details on the main system components.
2.2.1 Cryostat Assembly

Figure 2-1 shows the front view of the cryostat. The cryostat assembly contains the cryogenic components of the system, including the superconducting magnet, sample chamber, and pulse-tube assembly for the cryocooler. It also contains some gas handling valves and electronics.

The exterior surface of the cryostat is composed of a fiberglass housing. The cryostat cover (on top) can be removed by simply lifting it vertically. This exposes the electronics and integrated gas handling hardware. This includes the chamber vacuum gauge (Node 13 on the CAN bus) and the cryostat utility controller (Node 14 on the CAN bus).

Both the cryostat cover and the fiberglass side panels are attached to a steel magnet shield. The lower part of the shield is shown in the figure. With 9 Tesla systems, this shield maintains less than 5 gauss stray fields very near the exterior surface of the cryostat cabinet, allowing it to be installed close to other sensitive instruments in a laboratory.

The current sample temperature and magnetic field are displayed on the two red LED displays on the front of the cryostat. Note that the “sample temperature” may be different than the temperature of the sample chamber itself. For example, when operated with the Dilution Refrigerator, the temperature displayed would be that of the sample platform on the refrigerator. See section 4.3.4 for details.

The sample chamber access port is shown on the top of the cryostat. This port is a standard KF-40 flange, the same as the standard PPMS. All samples and experiment probes are inserted here.

The front “deck” is meant to stand on when installing and removing samples and measurement hardware. The deck is designed to be removed if needed to fit through small doorways.
Figure 2-2 shows the back of the cryostat where the connections are made to the high pressure (200 to 300 psi) helium lines from the cryocooler compressor assembly. The hoses are double-sealing Aeroquip-type. Note that the small connector corresponds to the high-pressure flow from the compressor and the large connector is the lower pressure return.

Also shown in the figure is the “moisture wick.” This wick is a synthetic cloth extending from the base of the inner vacuum vessel to a region outside the magnetic shield. It is designed to wick excess condensed moisture from the case of the vacuum vessel. In humid climates, water can condense on the inner vacuum vessel when the vessel is automatically vented with air during an automated warm-up procedure (see Section 3.2.8.2). Under normal operation conditions, there should be no moisture present either inside the magnetic shield, or visible at the moisture wick.

### 2.2.2 CAN Module Bay

Figure 2-3 shows the top of the CAN module bay. It is attached to the cryostat shield near the gray Lemo connector. The gray Lemo connector is the main electrical connection to the sample chamber.
Most measurement options and inserts require a connection between this port and one or more modules located in the CAN module bay.

The module bay hosts ten CAN modules. One module (in the back-most bay) is dedicated to the core DynaCool system operations (chamber temperature control), while the remaining nine are for optional measurement and control modules.

2.2.2.1 CAN POWER SUPPLY AND POWER DISTRIBUTION

Because of the large number of empty slots in the module bay, it is usually not necessary to remove and install modules unless a new module is being installed for the first time, or a defective module is being removed. However, if it becomes necessary to install or remove a module, it is critical that the power switch on the back of the module bay be turned off. The module power switch is located with the main power inlet as shown in Figure 2-4 below.

**WARNING!**

You must turn off the power to the module bay using the switch on the back of the bay whenever removing or installing CAN modules. “Hot plugging” can destroy a module.

The module bay gets 200-230 VAC main power from the Cabinet. This is used for the +/-24 volts regulated power supply which provides power for the CAN module bay. One spare 200-230 VAC outlet is provided on both the front and back panels of the module bay. These are for connecting external options that require AC power. Turning off the power to the Module bay using the power switch shown at lower right in Figure 2- will turn off power to the modules in the bay, and the top plate electronics (chamber vacuum gauge and cryostat utility controller) located on the cryostat top plate under the cryostat cover. It will also turn off the power to any optional devices that get their power directly from one of the CAN connectors on the module bay.
2.2.2.2 CAN NETWORK CONTROLLER AND DISTRIBUTION

The module bay also contains the CAN network controller. This is a device enabling communications between the PC and all of the devices on the CAN network. The back panel of the module bay (Figure 2-4) shows the CAN network controller and associated connections. A USB cable from the computer provides power and communications to the network controller. A pair of indicator lights above the USB connector can indicate the status of the CAN network controller:

- **PWR**: solid red indicates power from USB but no communications to PC; solid green indicates power and communications to PC.
- **DATA**: rapid green flashing indicates low speed communications on CAN bus; rapid red indicates higher speed communications.

In addition to the CAN network connectors located inside each of the CAN bays in the top of the module bay, there are five additional 9-pin D-sub connectors for connecting CAN devices. Four are located on the back as shown in Figure 2-4. One is located on the front panel of the module bay (see Figure 2-1). Two of these connectors on the back panel are dedicated to the DynaCool system (one for communications to the top plate electronics and the other for the cabinet electronics). Each of the 9-pin D-sub connectors can provide regulated power (+/- 24 V) for external CAN devices. Fuses for this DC power are located on the module bay back panel as shown in Figure 2-4. Note that while some CAN devices like the cryostat top plate electronics use this power, other devices like the pump cabinet have their own independent regulated power supply.

The CAN reset button is also located on the back panel as shown in Figure 2-4. Pressing this button (recessed) will cause all devices that listen for QD-CAN reset to reboot. The following devices do not listen to QD-CAN reset, and therefore must be reset separately:

- **Cryostat Controller**: Press the reset button on the back of the Pump Cabinet to reset the cryostat controller.
- **Magnet Controller**: Press the reset button on the magnet controller to reset it. You can access this button by removing the front panel of the pump cabinet (see Section 2-13).
- **Chamber Vacuum Gauge**: Power cycle the CAN Module Bay to reset the chamber vacuum gauge.

2.2.2.3 MAGNET SIGNAL DISTRIBUTION

This panel also contains a magnet signal patch. These three connectors merge separate signals paths from the magnet controller and optional low-field controller into a single cable going to the magnet in the cryostat.
2.2.3 Pump Cabinet and Computer

The pump cabinet (Figure 2-5) serves as both a workstation and also a container for the following components:

- **Circulation Pump**: This is a sealed scroll pump that is used for circulating helium past the sample chamber for cooling the sample. The outlet of the pump flows at relatively high pressure (500 to 800 Torr) to the cryostat where it is cooled and partially liquefied before passing through a flow impedance and into the annulus surrounding the sample chamber. It is then pumped at lower pressure (5 to 50 Torr) back to the inlet of the pump. This scroll pump requires regular maintenance at approximately 6 months intervals. Refer to Chapter 5 for service instructions.

- **Chamber/Case Pump**: This is a low capacity scroll pump for evacuating the sample chamber during chamber pump and purge operations. It is also used during initial system startup to evacuate the vacuum case.

- **Gas-handling manifold**: The gas-handling manifold contains solenoid valves, pressure gauges, pressure regulators, and various gas interconnections to manage the flow of gas in both the chamber gas circuit and the circulation loop circuit. There are several modes of operation this serves. Refer to Chapter 4 for more information.

- **Cryostat Controller Electronics**: The cryostat controller electronics contains thermometer and heater circuits for managing the operation of the cryostat. The cryostat controller also
communicates with the cryocooler system (compressor) and controls all the gas-handling valves and gauges on the gas-handling manifold and at the cryostat top plate. It operates as Node 5 on the CAN bus.

- **Magnet Controller:** This is the power supply for the superconducting magnet in the cryostat. It sources the ~55 amps required to drive the 9 Tesla magnet to full field. It operates as Node 6 on the CAN bus.

- Personal Computer (PC) running the Windows operating system and MultiVu measurement software.

- Main 200-230 VAC power inlet and distribution for the system.

For maintenance, the front and side panels of the cabinet can be removed. Most of the panels are held on using ball studs. These can be removed by simply pulling the panel outward. For safety reasons, some panels require remove of screws. These screws are clearly exposed on the relevant panel surfaces.

---

**WARNING!**

You should not operate the cabinet for more than a few minutes at a time with panels removed, since the panels are critical for proper air-cooling of all the components in the cabinet.

---

### 2.2.3.1 GAS HANDLING CONNECTIONS

The right side of the cabinet (see Figure 2-5) contains a bulkhead connector for 4 stainless flexible hoses with face-sealing “VCO” style fittings. These hoses are as follows:

- **Annulus Pumping Line:** This large hose goes to the inlet of the Circulation Pump in the cabinet and carries the return flow of the circulation loop that cools the sample chamber.

- **Return Line:** This hose sends the circulating helium from the circulation pump back to the cryostat to complete the helium circulation.

- **Chamber/Case Line:** This hose connects the chamber/case pump and manifold in the cabinet with the sample chamber and manifold in the cryostat. Under normal operating conditions this line enables venting, pumping, and purging of the sample chamber. During system startup and other maintenance operations, this line is also used to purge and evacuate the cryostat vacuum case.

- **Helium Bottle Line:** This hose is connected to the Helium gas supply bottle and regulator. This port provides helium gas for sample chamber venting and purging operations. It also provides gas for charging the helium circulation loop.
2.2.3.2 BACK PANEL AND CABINET BAYS

Figure 2-6 shows the back of the cabinet and the various connections.

The open bay at the top contains the PC. AC power (200-230 VAC) is provided to the PC, monitor and other peripherals using the four IEC C13 female connectors in the side of the computer bay. The computer is mounted to a metal sliding drawer assembly. To access connectors on the backside of the computer, it may be necessary to remove the screws holding this drawer assembly onto the black plastic.
rails that are attached to the floor of the computer bay. Alternatively, remove the front panel from the cabinet to access the rear of the computer.

Below the open computer bay is the covered magnet controller bay. The power supply gets AC power and CAN network connectivity from connectors in the side of the bay. The magnet current leads and magnet signal cable pass through the side notch on bay cover (on the left of Figure 2-6). The easiest way to gain access to the power supply bay is by removing the panel on the front side of the cabinet rather than the rear panel.

Below the magnet controller bay is the main AC power distribution panel with the main power inlet and breaker along with 4 sub-system breakers. From left to right, the sub system breakers are:

- **MODULE BAY AND COMPUTER:** This 10 Amp breaker switches the power to the outlets in the computer bay and also the AC power line supplying the module bay. Do not use this breaker to turn off the power to the module bay since you will lose power to the computer. Instead use the power switch on the back of the module bay for this (see Figure 2-4).

- **MAG PWR 12 A:** This 12 Amp breaker switches power to the large IEC C19 connector below the magnet controller bay. This is usually used only for 14 T DynaCool systems.

- **MAG PWR 10 A:** This 10 A breaker switches power to the IEC C13 connector inside the magnet controller bay. This is usually used for 9 T DynaCool systems.

- **CABINET:** This 10 A breaker switches the power to the pumps and gas handling instruments inside the pump & gas-handling bay in the bottom of the cabinet. It also switches power to the control electronics located in the side of the pump cabinet. This breaker should be off when opening the side panel on the cabinet.

![Diagram of Cryostat Controller Electronics](future expansion)

thermometer & heater control (to cryostat)

power light for cryostat controller

regulated power breakers for CAN out

CAN network in (from module bay)

CAN network out (with terminator)

reset button (cryostat controller only)

cryocooler control (to compressor)

valve & flow control (to cryostat)

Figure 2-7. Connectors to the Cryostat Controller electronics on the back of the Pump Cabinet.

Figure 2-7 shows the vertical back panel of the Pump Cabinet with the connectors to the cryostat controller electronics. The cryostat controller contains thermometer bridges, heater drivers, valve drivers, and various other instrument electronics for communicating with the cryostat and the cryocooler compressor.
### 2.2.4 Cryocooler Compressor Assembly

![Cryocooler Compressor Assembly](image)

Figure 2-8 shows the cryocooler compressor. This unit drives the high pressure helium cycle for the pulse-tube cooler in the cryostat. It is connected to the cryostat by the two high-pressure helium hoses and the cold head power cable. It is connected to the pump cabinet by a serial cable. Start and stop operations are controlled remotely over the serial cable and so it is not necessary to have direct access to the compressor except for maintenance or service. This makes it possible to locate the compressor remotely, up to 100 feet away, in a location that has access to cooling water and 3-phase power. This can also provide a degree of sound isolation between the laboratory space and the relatively noisy compressor.

The DynaCool system is designed to operate continuously between compressor maintenance cycles, which should be regularly scheduled for every 20,000 operating hours. A timer is located on the front of the compressor to help you track when you will need to schedule equipment maintenance. It is important to adhere to the maintenance schedule, and to facilitate this, we have provided a maintenance log in Chapter 5.

**WARNING!**

The cryocooler system can be seriously damaged if the required servicing is not performed. Other system components also should be serviced at the same time as the compressor.

Only qualified Quantum Design service personnel should perform maintenance work on the cryocooler. Contact your Quantum Design service representative to schedule maintenance on the cryocooler.

Please refer to the Cryomech User Manual for additional information about this compressor.
2.2.5 Helium Gas Bottle and Regulator

![Helium gas bottle with regulator.](image)

The DynaCool system uses a helium gas supply cylinder and a bottle-mounted pressure regulator to provide helium gas for charging the circulation loop and for venting and purging the sample chamber. The gas cylinder and regulator should be connected to the system at all times. Additional precision pressure regulators are located in the pump cabinet to provide further pressure reduction and regulation for both the circulation loop and sample chamber.

Helium gas consumption depends on your use of the system. A cool down will require approximately 500 liters STP of helium to charge the circulation loop. A typical purge or vent operation will use less than 10 liters. A full standard size gas cylinder contains about 8000 liters STP.

The regulated pressure (gauge on left) should be set to 15-20 psi (0.10-0.14 MPa). Replace the helium cylinder when the cylinder pressure (gauge on right) falls below about 300 psi (2 MPa). See Section 5.2 for replacement instructions.

2.3 Measurement System Hardware

2.3.1 Sample Pucks

The sample puck (Figure 2-10) is a unique modular component that gives PPMS DynaCool great flexibility. For many measurement options, the puck is a sample holder that provides both thermal and electrical connections to the bottom of the sample chamber. The Electrical Transport Option (ETO) is a good example of a measurement option that uses a puck in this way. Other options, such as the
Vibrating Sample Magnetometer (VSM) option, use a specialized version of the puck that integrates portions of the measurement instrumentation directly in the puck assembly.

![VSM puck diagram]

All the different measurement pucks have a common connector configuration for plugging into the sample chamber. The puck is a 2.3 cm (0.91 inch) diameter disk constructed of high conductivity copper for maintaining high thermal uniformity. The puck is gold plated to prevent oxidation, and in the simple configuration shown in the figure, provides a surface on which samples can be mounted with good thermal contact. When the puck is installed in the sample chamber, the system block is mounted in the sample chamber “block” directly beneath the installed puck, providing intimate thermal contact between sample and thermometer. Measurement options like the VSM provide an integrated thermometer on the puck assembly close to where the sample is positioned. See Sections 4.3.1 and 4.3.4 for details about thermometry.

The base of the basic puck contains 12 solder pads to allow connection of the sample (or other measurement option hardware) to the experimental sample wiring. These solder pads are connected to a set of 12 sockets on the base of the puck, which contact pins in the bottom of the sample chamber. Most option-specific pucks are pre-wired for a specific type of measurement, like for example, the ETO option pucks that extend the electrical connection to a convenient mounting frame on the top-side of the puck. The puck is keyed to ensure that the electrical connectors properly align. See Section 2.3.7 for details on experimental wiring. See Appendix C for an experimental wiring pin out diagram.

### 2.3.2 Puck-Insertion Tool

The puck-insertion tool is a long rod used for installing pucks in the sample space. The lever of the puck-insertion tool is engaged when it is lying flat across the handle, as is shown in Figure 1-4. When the lever is engaged, the tool grips the puck by a groove in its outer rim.

![Puck-insertion tool diagram]
The puck-insertion procedure is described in Section 1.5.2. Please read that section before using the tool.

**WARNING!**

Read section 1.5.2 before attempting to insert a puck into the sample chamber. Failure to follow the directions correctly could damage the system.

### 2.3.3 Sample Chamber Access Port and Chamber Baffles

The sample chamber is accessed through the KF-40 flange mounted to the cryostat top plate manifold. In order to seal the flange and prevent thermal radiation from reaching your sample, you use the baffle set which is attached to the KF blank flange as shown in Figure 2-12. In order to prevent leaks into the sample chamber, be sure to keep the sealing surfaces of the KF flange and baffle set clean. Also, be sure not to damage the O-ring used to seal this flange.

A threaded adapter is present on the end of the rod in order to allow the attachment of accessories, such as the contact baffle used with the Heat Capacity and Thermal Transport Options.

Note that some DynaCool options seal the sample chamber differently and do not use the components shown in the figure.

![Diagram of Sample Chamber Access Port and Baffle Set](image)
Before setting a temperature below 295 K, you should always be sure that the sample chamber is sealed and contains only clean gas. Normally you do this by executing a purge and seal operation after sealing the KF flange at room temperature. Failure to do so can cause contaminants to freeze inside the sample chamber, causing problems with many experiments. Measurement options provide sample installation wizards that perform chamber operations at the appropriate times when installing samples.

**WARNING!**

Be sure to properly seal the sample chamber KF flange before setting temperatures below 295 K. Failure to do so will cause ice to build up in the chamber, a condition that is hazardous and may damage the DynaCool sample chamber due to excessive pressures resulting from an ice plug. Even a small leak can cause ice to build up, so be sure to keep the KF flange surfaces clean and to not damage the O-ring used to seal the flange.

### 2.3.4 Cryopump

The cryopump is used to achieve high vacuum in the sample chamber, typically $< 10^{-4}$ Torr. This is necessary for options like Heat Capacity and VSM Oven to provide thermal isolation between the sample and the chamber. The cryopump is permanently mounted in the cryostat vacuum case and is controlled automatically by the system software.

Cryopumping is achieved by exposing the sample chamber volume to a multi-stage cryopump chamber consisting of cold metal surfaces at about 70 K and charcoal cooled to about 4 K by the cryocooler system in the cryostat. The high vacuum valve isolates the sample chamber volume from the cryopump chamber when high vacuum is not required.

Long-term operation of the cryopump requires that the contaminant gases and adsorbed helium be removed from the metal surfaces and charcoal. This process is called regeneration and is performed during a standard cryostat startup operation when the cryostat is still warm. The capacity of the DynaCool cryopump is such that it should not require regeneration more often than the cryostat itself requires regeneration. Heaters on the cryopump make it possible to regenerate the cryopump while the cryostat is cold. Contact Quantum Design Service if you need to perform this operation.

You can prevent the need to perform an unscheduled regeneration by keeping the sample chamber clean. Avoid placing wet objects, such as a cold baffle set that has condensed water on it, in the sample chamber. Be sure to purge and seal the sample chamber before attempting to set high vacuum.

### 2.3.5 Puck Adjustment Tool

The puck adjustment tool (Figure 2-13) is used to adjust the position of the fingers of the puck so that the fingers maintain solid thermal contact with the thermal interface located at the bottom of the sample chamber. This is especially important for measurement options such as Heat Capacity or VSM Oven where the puck operates in a thermal isolation vacuum. Use the puck adjustment tool after you have inserted the sample puck into the sample chamber approximately 10 times or whenever the puck fits loosely into the bottom of the chamber.
Complete the following steps to use the puck adjustment tool:

1. Place the puck on the finger spreader. Refer to Figure 2-13. If there are two small screw heads on the bottom of the puck, such as on a heat capacity puck, be sure to align them with the cut outs on the spreader.

2. Press the puck downward and continue pressing until all the chuck fingers touch the base of the finger spreader. When all the fingers touch the base of the spreader, the spreader evenly applies radial force to the fingers, pushing them outward and slightly beyond their optimal location.

3. Remove the puck from the finger spreader.

4. Place the puck inside the finger contractor. Refer to Figure 2-13.

5. Press straight down on the puck and continue pressing until you press the puck completely into the finger contractor. When the entire puck is in the contractor, the contractor evenly applies force to the outside of the fingers, pushing them inward. The contractor pushes the fingers—regardless of external wear or variations on the puck—so that the fingers obtain their optimal location.

6. Remove the puck from the finger contractor.

7. Place the puck inside the test cutout. Refer to Figure 2-13. Verify that the puck fits easily but snugly inside the test cutout. Do not insert the puck into the sample chamber if it does not fit into the test cutout, doing so could cause damage to the sample chamber.

### 2.3.6 Puck Wiring Test Station

The puck-wiring test station (Figure 2-14) is used to verify the integrity of the wiring between a sample and puck or the wiring of any option hardware present on a puck. The test station contains three sets of contacts, all wired in parallel: a Lemo connector identical to the sample chamber connector on the probe head, a puck connector, and 12 banana jacks. DynaCool measurement options each come with a plastic overlay that can be placed over the banana jacks on the test station with convenient labels for each of the signals.
2.3.7 Experiment Puck Wiring

The experimental wiring in DynaCool consists of the following components:

- The gray Lemo connector to the right of the cryostat cover (see Figure 2-3).
- A cable under the cryostat cover running between the Lemo connector and the sample chamber.
- The cryogenic sample chamber wiring running from near the sample chamber access port (see Figure 2-1) down the outer wall along the length of the sample chamber to the “block” at the bottom of the sample chamber.
- The vacuum-tight electrical feedthrough at the bottom of the sample chamber.
- The puck connector which plugs into the opposite side of the vacuum-tight feedthrough at the bottom of the chamber.

See Appendix C for a pin out diagram of the puck wiring.

2.3.8 CAN Modules

Measurement electronics are contained within modular electronic housings, commonly called CAN modules. A typical CAN module is shown in Figure 2-15. Connections to measurement hardware are made on the front panel, which is shown in the figure.
The 9-pin QD-CAN D-shell connector on the bottom panel (Figure 2-16) of the modules connects to power, CAN, and synchronization lines in the module bay, described in Section 2.2.2.

CAN modules communicate with PC, other system components (e.g., chamber vacuum gauge), and each other via the CAN system network. Section 2.2.2.2 describes this in more detail.

The base DynaCool system is configured with only a single CAN module in the module bay (Temperature Control Module) used for certain temperature control functions. However, most measurement options have at least one CAN module containing option-specific instrumentation.

For a detailed description of specific CAN modules, consult the relevant measurement option manual. For instructions on insertion and removal of CAN modules, see Section 2.2.2.1.
CHAPTER 3

Software

3.1 Overview

This chapter describes the MultiVu, Windows™ software and also the background services running on the PC that manages the lower level temperature, field, and cryostat control functions. Figure 3-1 shows the relationship between MultiVu and these other software components.

Figure 3-1. Overview of software applications running on PC.
MultiVu is the primary user interface that allows user control of the operation of DynaCool. It combines, in a single user interface, the basic instrument control and status reporting (Section 3.3), measurement data collection (Section 3.4), sequence editing and sequence execution (Section 3.5), and graphing (Section 3.6). In addition to these features, MultiVu also contains instrument utilities, diagnostics, and error reporting.

The Temperature, Magnet, and Cryostat services run as Windows services in the background and their operation is indicated by the icon located in the Windows tool tray in the lower right of the screen. See Section 3.7 for more information.

The CAN Manager software provides CAN network communication services to all software on the PC, including MultiVu and the control services. The operation of CAN Manager is indicated by the icon also located in the Windows tool tray in the lower right of the screen. Double-click or right-click for more information.

3.2 MultiVu

![MultiVu Main Window](image)
The main MultiVu window is shown above. This window displays essential status information about the instrument and allows control of the instrument with simple mouse click commands. The tool bar, control center, sequence command bar, and status bar may each be docked and undocked by double-clicking any non-control region or by dragging them around the main window. They may also each be hidden using the “View” menu.

### 3.2.1 Menu Bar

The Menu Bar contains menus for accessing all fundamental software features.

![Main Menu Bar](image)

**Figure 3-3. Main Menu Bar**

- **FILE** - File menu contains commands for opening, closing, and printing sequence files and data files; for saving sequence files, graph files and graph template files; for generating new sequence files; and for exporting data files to alternate formats.
- **EDIT** - Edit menu contains commands to edit sequence files. It is not shown unless a sequence window is selected.
- **VIEW** - View menu allows you to show and hide the various components of the MultiVu graphical user interface, and to open different types of data file windows (graph view, table view, record view, raw data view.)
- **SAMPLE** - Sample menu helps you install, remove, and locate samples and enter sample properties that are recorded in the data file. This menu is populated only when a measurement option is active.
- **SEQUENCE** - Sequence menu contains commands to control the execution of sequences and to access the underlying script for advanced sequence editing.
- **MEASURE** - Measure menu contains commands to control measurements executed by measurement options. This menu is populated only when a measurement option is active.
- **GRAPH** - Graph menu helps you manipulate the appearance of data file graph windows.
- **INSTRUMENT** - Instrument menu contains commands to control the temperature, magnetic field, and atmosphere state of the sample chamber, and to put the instrument into shutdown mode when unused.
- **UTILITIES** - Utilities menu contains commands to activate and configure measurement options, and to help maintain and troubleshoot the instrument, including cooling the system down and logging diagnostic data. (See Appendix B for more information.)
- **WINDOW** - Window menu helps arrange the open windows in MultiVu.
- **HELP** - Help menu contains version and serial number information about DynaCool, and access to the user documentation.
3.2.2 Tool Bar

The Tool Bar contains shortcuts for common menu items.

3.2.3 Control Center

The Control Center (Figure 3-5) shows the currently selected sequence file name and sequence execution status. In addition, there are buttons to change the selected sequence and edit, run, pause, abort, or lock the selected sequence.

3.2.4 Sequence Command Bar

The Sequence Command Bar (Figure 3-6) is shown when you edit sequences. You can toggle its display by selecting the “View > Sequence Command Bar” entry while editing a sequence. It contains commands you may insert into the sequence. Commands are organized in a tree structure. Click “+” and “-” to expand or collapse tree branches. Double click commands to insert them into the sequence.
Measurement option sequence commands are present in the “Measurement Commands” branch when a measurement option is active. More on sequences is found in Section 3.3.

<table>
<thead>
<tr>
<th>Sequence Commands:</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Commands</td>
</tr>
<tr>
<td>Beep</td>
</tr>
<tr>
<td>Call Sequence or Script</td>
</tr>
<tr>
<td>Chamber Operations</td>
</tr>
<tr>
<td>Remark</td>
</tr>
<tr>
<td>Scan Field</td>
</tr>
<tr>
<td>Scan Temperature</td>
</tr>
<tr>
<td>Scan Time</td>
</tr>
<tr>
<td>Sequence Message</td>
</tr>
<tr>
<td>Set Field</td>
</tr>
<tr>
<td>Set Temperature</td>
</tr>
<tr>
<td>Standby</td>
</tr>
<tr>
<td>Wait</td>
</tr>
<tr>
<td>Measurement Commands</td>
</tr>
<tr>
<td>Log Data</td>
</tr>
<tr>
<td>Sigma Log Data</td>
</tr>
</tbody>
</table>

Figure 3-6. Sequence Command Bar

### 3.2.5 Status Bar

The Status Bar contains information about the status of the instrument. Click on the panels in the status bar to access dialogs for setting temperature, magnetic field, and chamber atmosphere actions. Click on the Cryostat status panel on the right to open the Cryostat Monitor dialog (see Section 3.3.8) for system startup, shutdown, and other maintenance operations.

Figure 3-7. MultiVu DynaCool Status Bar & Panels

### 3.2.6 Sequence Window

The Sequence Window is used for editing sequences. More than one sequence window may be open at a time. The selected sequence is always the sequence in the last sequence window that was active (clicked). The control center reports the selected sequence file name. The selected sequence is the sequence into which commands will be inserted when selected with the sequence command bar. The
selected sequence is also the sequence that executes when “Run Sequence” is selected, when the control center “Run” button is selected, or when the menu command “Sequence > Run” is selected.

3.2.7 Data Windows: Graph, Record, and Table Views

Data file contents can be viewed and browsed from within MultiVu using the graph, record, and table data view windows.

The Graph View data window shows a data file in graph format. Each point on the graph corresponds to a line in the data file and represents a single data record. A data record consists of several data items collected simultaneously, such as sample temperature, magnetic field, and magnetic moment. You may view a single data record in its own window by double-clicking any record in the graph view. The record view and graph view are linked, so that the highlighted point on the graph view corresponds to the record shown in the record view.

The appearance of the graph view may be manipulated extensively and templates may be applied to the graph view so that you do not need to set each graph characteristic individually. To learn more about manipulating the graph view, see Section 3.6.

In addition to the record and graph views, you can also view the data in a table, where each row in the table is a data record. Right-click in the graph view and select Table View to open the table view. Cells and groups of cells in the table view can be selected, copied, and pasted into spreadsheets and other graphing programs for additional analysis using the standard Windows™ copy and paste features.

3.2.8 Cryostat Monitor Dialog

The DynaCool Cryostat Monitor is used to perform basic system operations like starting up and shutting down the system. It also shows current status and sensor information from the cryostat. Open the Cryostat Monitor from the MultiVu “Instrument>>Cryostat...” menu item or by clicking on the Cryostat status panel (see Figure 3-7).
3.2.8.1 STATUS INFORMATION

The right panel of the monitor shows information about the internal workings of the cryostat system. Refer to Chapter 4 for a description of the cryostat architecture and theory of operation.

- **Cryostat State Machine Status** – The display box at the top of the status panel in Figure 3-8 shows the current cryostat state or mode (example, “Cold Cryostat”). This is a slightly more detailed version of the status shown in the Cryostat and Cryocooler panel in Figure 3-7. The normal operational state when cold is “Cold Cryostat”, however during warm up, startup or other operations, the cryostat state machine will pass through many other states.

- **Cryocooler** – Shows the status of the cryocooler system indicating compressor running or not running, as well as compressor errors.

- **Magnet** – Shows the temperature of the magnet, as well as the magnet state machine status.

- **4 K Plate** – Shows the temperature of the 4 K plate, as well as the second-stage heater power required to maintain a constant temperature at the 4 K plate.

- **Shield** – Shows the temperature of the radiation shield that is anchored to the first stage of the cooler.

- **Loop** – Shows the circulation loop pressure as measured at the outlet of the circulation pump. This pressure corresponds to the vapor pressure of the liquid in the cryostat cooler chamber. Also indicated is the status of the circulation loop as well as the state of the liquid in the cooler chamber. This status normally will only change during startup and shutdown operations.

- **Case** – Shows the status of vacuum can. Again, this status will only change during startup and shutdown operations.

3.2.8.2 CRYOSTAT CONTROL TASKS

The buttons on the left of the Cryostat Monitor are for initiating various cryostat operations like startup and shutdown. The buttons available at any given time will depend on the current cryostat state. For example if the cryostat is in the “Cold Cryostat” state, then the “Startup” task is not available. When a button is clicked, a description of the action to be performed is displayed along with “OK” and “Cancel” buttons displayed. Here are the most commonly used tasks:

- **Startup** – This operation will perform a complete system startup. This includes purging and evacuating the cryostat case, purging the circulation loop with helium, regenerating the cryopump, cooling the magnet to operating temperature, and preparing the circulation loop for temperature control. A complete system startup will take between 12 and 36 hours to complete. To resume a previously aborted startup, you may use Resume Startup instead.

- **System Standby** – This will operate the cryostat in a reduced-power standby mode. In standby, the cryocooler is turned on and off at regular intervals (one cycle every 1 to 2 hours) to consume the minimum power necessary to prevent loss of helium from the circulation loop. Full operation can be resumed from the standby state in less than 1 hour by clicking the Restart Cryostat button.

- **Restart Cryostat** – Depending on the current state, this will cancel the current shutdown operation and return to normal operation, or exit the current standby state and resume normal cryostat operation.

- **Warmup** – This will warm the cryostat to room temperature and shut the system down. This includes turning off the cryocooler, evacuating the helium from the circulation loop, venting the cryostat case with air (to speed warming), and turning on stage heaters until all cryostat
components are at room temperature. At room temperature the case will be pumped out to remove excess air, followed by power down. Use this command if you will be performing maintenance, or will need to cool the system down again shortly after warming it up. As an alternative, see the Shutdown command.

- **Shutdown** – This operation will turn off the cryocooler, evacuate the circulation loop, and turn off the power to the system. Use this command if you plan to shut the system down for more than a week and you don’t care how long it takes to warm up. As an alternative, see the Rapid Shutdown command.

- **Rapid Shutdown** – This operation will shut down power to the system without any further operations. Unlike the Shutdown, this operation will not evacuate the circulation loop. Use this operation as an emergency shutdown, or prior to software or hardware maintenance if you plan to restart the system within 30 minutes.

- **Refresh Liquid** – This operation will burn off and condense liquid helium in the circulation loop. It will take about 1 hour to complete. Run this operation if you suspect that the helium level in the cryostat is abnormally low.

- **Abort** – This operation will abort the current startup operation and shut down power to the system. Use this operation as an emergency shutdown to stop system startup. After executing this abort, you will have the option to choose Resume Startup to continue.

- **Resume Startup** – This operation will attempt to resume a system startup after a shutdown or abort of a previous startup operation. The operations performed will depend on the progress of the previous aborted startup operation. See Startup for a list of possible actions taken. If the cryostat is cold, this operation will not include purging and evacuating the cryostat case, purging the circulation loop with helium, or regenerating the cryopump. To force a complete startup, rather than resuming an existing one, make sure the cryostat is warm (4 K Plate > 270 K) and use the Startup command instead.

- **Cancel Recovery** – The availability of this button indicates that the system has gone into the “Recover Cooling” event and is currently attempting to recover cooling power from a magnet over-temperature event. This recovery state is meant to prevent a magnet quench by providing enhanced cooling power to the magnet to allow it to fully discharge. This recovery state should exit automatically when magnet charging is safe again. If the system fails to automatically recover cooling, you can use this operation to regain control of the cryostat.

### 3.2.9 Instrument Utility Tools

Under the menu item “Utilities > Tools >” you access utility programs that are used for maintenance and service operations. These tools are not used in typical day-to-day operation of the instrument. Normally you use these tools when instructed by Quantum Design Service. Items in the Tools menu include:

- **CryoMon** - Runs CryoMon.exe, a program which shows a diagram representation of the DynaCool cryogenics and gas handling system along with live sensor readings.

- **Macro Manager** - Opens a dialog that shows all running WinWrap macros, including the foreground macro and background macros.

- **Open Tools Directory** - Opens the directory c:\QDDynaCool\Tools\ in Windows Explorer. This is the location of executable files described in this section.
Pump Maintenance - Runs PumpMaintenance.exe, a program that guides you through the steps to remove and then reinstall the circulation pump while the system is cold. You use this tool to perform tip seal maintenance on the pump (see Section 5.3) or replace the pump.

Replace Chamber - Opens ReplaceChamber.exe, a program that guides you through the steps to replace the sample chamber while the system is cold. You perform this operation if the sample chamber is damaged and you have a replacement sample chamber from Quantum Design.

Service Control - Open the Service Control utility (ServiceControl.exe), which is described in Section 3.6.

Table2D - Opens Table2D.exe, the viewer/editor for thermometer magneto-resistance correction tables (2D tables).

TCM Control - Opens TCMControl.exe, a program that allows manual control of the Temperature Control Module and shows live sensor readings. This tool should be used to control the Temperature Control Module only by qualified Quantum Design Service personnel.

Versions - Opens Versions.exe, which reports all DynaCool software and firmware version numbers and allows you to compare them to expected version numbers using a "package listing" file supplied by Quantum Design.

Warm System Test - Runs Warm System Text.exe, a program that verifies various sensor readings when the system is warm. You use this tool to make sure all cables and hoses are properly connected before cooling a system down. It is only necessary to use this tool when cables and/or hoses have been disconnected then reconnected, such as on initial installation or after moving the system.

3.3 Measurement Options

Most measurements in DynaCool require the use of measurement option software. You do not use a measurement option if you provide the measurement electronics, but all measurements provided by Quantum Design require option software to be active. For details on the process of setting up a measurement option, see the relevant option manual.

In order to activate an option, first set up the option hardware as described in the option manual. Then select the menu item “Utilities > Activate Option…” You will be presented with a dialog showing available measurement options. Select the desired option and press the “Activate ->” button. The option software will start within the MultiVu window, and will initialize the option hardware. The measurement option will display a control center from which you can:

- Configure the option
- Insert and remove samples
- Set up data files
- Perform immediate-mode (not sequenced) measurements
To perform sequenced measurements, you write and execute a sequence in MultiVu as described in Section 3.4.

3.4 Sequences

Operation of DynaCool is automated using sequences. Sequences are simple computer programs instructing the instrument to carry out a number of operations in a predetermined order. Simple looping is supported in sequences, but branching is not. Operations typically found in a sequence file include changing the sample temperature, changing the magnetic field, and measuring some property of the sample (depending on which measurement option is active). Additionally, commands may be placed in sequences to log diagnostic data, record a comment in the data file, begin recording data to a new data file, generate a message on the computer screen, and even run another sequence.

MultiVu is also used to run, pause, lock, and abort sequences on DynaCool and to view the status of sequences as they run.
3.4.1 Editing Sequences

- Create a new sequence file by clicking “New Sequence” or selecting the menu item “File > New Sequence.”

- Open an existing sequence file for editing by clicking “Open Sequence” or selecting the menu item “File > Open… > Sequence.” You will be prompted to locate the file you want to open.

- The top of the sequence window shows the sequence file name. An asterisk symbol (*) after the file name means the sequence has changed since last time the file was saved. Sequences must be saved before you run them.

- Save a sequence file by clicking “Save Sequence” or selecting the menu item “File Save.” If not already assigned, you will be prompted for a location and file name.

- Add a command to the selected sequence by double-clicking the command in the sequence command bar. The new command is inserted above the highlighted command in the selected sequence window. You will first be presented with a pop-up window to fill in command-specific information. Then a summary of the command will appear in the sequence window. More detail about each available sequence command is found at the end of this section.

- Remove and reorganize sequence commands by highlighting them in the sequence window and using the “Cut,” “Copy,” “Paste,” “Delete,” and “Undo” commands in the “Edit” menu.

- Disable commands in a sequence file without deleting them using “Edit > Disable.” Enable a disabled command with “Edit > Enable” (Figure 3-9). A disabled command will be skipped during sequence execution. Disabled commands are preceded by an exclamation mark symbol (“!”) in the sequence window and are changed from black text to gray text. With this feature you may decide to execute or not execute some commands just prior to run time based on the immediate circumstances. For example, you may wish to disable a series of commands that fall outside the meaningful measurement range for certain samples.

- All of the commands found in the “Edit” menu are duplicated in a pop-up menu when you right-click any sequence window.

![Figure 3-10. Disabling Sequence Commands](image)
3.4.2 **Advanced Script Editing**

Before running sequences, MultiVu automatically compiles sequence files into Visual Basic for Applications (VBA) scripts. Users with programming experience may compile this script without running the sequence, and may then edit the script directly and run the edited script (macro). VBA scripts give the user the ability to perform branching and more sophisticated loops than standard sequences. Also, communication with third-party instruments via GPIB is possible in VBA scripts. (You must supply GPIB hardware.)

However, Quantum Design cannot certify the instrument behavior when it is automated with user-designed scripts. Many checks and safeguards can be bypassed when running a VBA script directly. Novice users should not use this feature. Advanced users with programming experience should use this feature with caution.

- Compile and edit the sequence script using the menu commands “Sequence > Advanced > Compile Macro” and “Sequence > Advanced > Edit Macro.” A WinWrap Basic editor window will appear.
- Run the script with the menu command “Sequence > Advanced > Run Macro.” You will be prompted to locate the script file to run. Or you may run the script by clicking the “Start/Resume” button in the WinWrap Basic editor window.
- Find more information about the WinWrap BASIC editor and scripting language by right clicking in the WinWrap BASIC editor window and selecting “Help > Editor Help” and “Help > Language Help”.

3.4.3 **Running Sequences**

If the sequence file you want to run is not open, you need to open it. Open an existing sequence file by clicking “Open Sequence” or selecting the menu item “File > Open… > Sequence.” You will be prompted to locate the file you want to open.

- To execute a sequence, it must be the selected sequence. If more than one sequence window is open, make sure the selected sequence is the sequence you want to execute.

- Execute the selected sequence by:
  - Selecting “Run Sequence”
  - OR
  - Selecting the menu command “Sequence > Run.”
  - OR
  - Selecting the “Run” button on the control center.

- The status bar and the control center both display the status of the sequence execution. The sequence window also highlights the line currently being executed in green.

- The toolbar, “Sequence” menu, and command center all provide the ability to pause and abort sequence execution also. When paused, the sequence window highlights the active line of the sequence in yellow.
3.4.4 Locking Sequence Execution

- When the sequence execution is locked, a sequence cannot be run, paused, or aborted without first unlocking sequence execution. You cannot exit MultiVu when sequence execution is locked.

- No key or password is required to lock or unlock sequence execution. The feature is intended only to prevent careless and accidental interference with instrument operation. It is not a security device and does not protect against malicious behavior.

- The instrument does not need to be running a sequence to lock sequence execution.

- Lock sequence execution by clicking “Lock Sequence,” selecting the menu item “Sequence > Lock,” or click the “Lock” button on the control center. Type in your name and additional information so other users know why the sequence is locked, then click the “Lock” button. All run, pause, and abort controls in the graphical user interface are disabled.

- Unlock the sequence by clicking “Lock Sequence” again, selecting the menu item “Sequence > Unlock,” or the “Unlock” button on the control center. Then click the “Unlock” button on the popup dialog, which displays the name and message of the person who locked sequence execution.

3.4.5 Sequence Commands

The following sequence commands are present in DynaCool with no measurement option activated. Additional measurement commands are available when using an option.

3.4.5.1 SYSTEM COMMANDS

- **Beep** – Causes the computer to make the Windows default beep sound.

- **Call Sequence** – Suspends execution of parent sequence file and begins execution of selected child sequence file or script file. When execution of child sequence file or script is complete, execution of parent sequence will continue with the next line.

- **Chamber Operations** – Changes the state of the sample chamber atmosphere (Figure 3-1). See Section 4.5.1 for a description of chamber operations.

![Sample Chamber Atmosphere Control Center](image)
• **Remark** – Serves as a message, comment, or visual break for the user only. Does nothing during sequence execution.

• **Scan Field** – Creates a program loop for executing repeated commands at user-defined magnetic field increments. All commands between the “Scan Field…” line in the sequence and the “End Scan” line in the sequence will be repeated at each magnetic field specified by the scan field command. Set the initial and final fields and the scale on which the field increments should appear uniform (linear, H2, H1/2, 1/H, log (H)). Also set the total number of field steps. (For uniform linear spacing, you may alternatively set the field increment.) Finally, specify the rate and approach mode used by the magnet controller to achieve each set point:
  o Linear: Controller will drive directly to each field and attempt to maintain the specified charging rate as closely as possible until each set point is reached. At each set point the field will stabilize until the commands within the loop are completed.
  o Oscillate: Controller will intentionally overshoot each set point by 70% of the total field change, at the desired rate, and will then oscillate into the set point field in smaller and smaller overshooting steps. At each set point the field will stabilize until the commands within the loop are completed. This is intended to eliminate flux motion in the superconducting magnet windings, yielding a very stable magnetic field and reduced remanence.
  o Sweep: Controller will drive directly from the initial field to the final field without stopping. Each time a field increment defined by the command is reached, the commands inside the scan field loop will be executed, but the field will continue to ramp while they execute.

• **Scan Temperature** – Creates a program loop for executing repeated commands at user-defined temperature increments. All commands between the “Scan Temperature…” line in the sequence and the “End Scan” line in the sequence will be repeated at each temperature specified by the scan temperature command. Set the initial and final temperatures and the scale on which the spacing of the temperature steps should appear uniform (linear, 1/T, log(T).) Also set the total number of temperature steps. (For uniform linear spacing, you may alternatively set the temperature increment.) Finally, specify the rate and approach mode used by the temperature controller to achieve each set point:
  o Fast: Controller will drive directly to each temperature and attempt to maintain the specified sweep rate as closely as possible until each set point is reached. At each set point the temperature will stabilize until the commands within the loop are completed. A small temperature overshoot can occur in this mode.
  o No Overshoot: Controller will drive to each set point at the desired rate until it is close to the set point, and will then slow the rate to avoid temperature overshoot. At each set point the temperature will stabilize until the commands within the loop are completed. This is intended for use with highly temperature-hysteretic samples.
  o Sweep: Controller will drive directly from the initial temperature to the final temperature without stopping. Each time a temperature increment defined by the command is reached, the commands inside the scan temperature loop will be executed, but the temperature will continue to change while they execute.

• **Scan Time** – Creates a program loop for executing repeated commands at user-defined time increments (or immediate repetitions with no time increment.) All commands between the “Scan Time…” line in the sequence and the “End Scan” line in the sequence will be repeated at each time specified by the scan time command. Set the total time in seconds and specify whether the spacing of events should be uniform in time or logarithmic in time. And specify the number of steps. This is the number of times the loop will be repeated. (For uniform spacing in time, you may alternatively specify the time increment.) If the total time is set to zero seconds, then the number of steps defines how many times the loop will be repeated in rapid succession.
• **Sequence Message** – Displays a message on the computer screen and pauses sequence execution until the message is acknowledged or until a timer expires. If the computer is set up with network access and access to a mail server, a message can also be emailed with attachments such as data files.

• **Set Field** – Sets the instrument’s magnetic field. Specify the field, the charging rate, and the approach:
  
  - Linear: Controller will drive directly to the field and attempt to maintain the specified charging rate as closely as possible.
  - Oscillate: Controller will intentionally overshoot the set point by 70% of the field change, at the desired rate, and will then oscillate into the set point field in smaller and smaller overshooting steps. This is intended to eliminate flux motion in the superconducting magnet windings, yielding a very stable magnetic field and reduced remanence.

Notice that sequence execution continues with the next command in the sequence as soon as the field is set, not when the field set point is achieved. To wait for a stable magnetic field before executing the next command, use the Wait command.

• **Set Temperature** – Sets the sample temperature. Specify the temperature, the rate, and the mode:
  
  - Fast Settle: Controller will drive directly to the temperature and attempt to maintain the specified rate as closely as possible until the set point is reached. A small amount of temperature overshoot can occur in this mode.
  - No Overshoot: Controller will drive to each set point at the desired rate until it is close to the set point, and will then slow the rate to avoid temperature overshoot. This is intended for use with highly temperature-hysteretic samples.

Notice that sequence execution continues with the next command in the sequence as soon as the temperature is set, not when the temperature set point is achieved. To wait for a stable temperature before executing the next command, use the Wait command.

• **Shutdown** – Places the instrument in shutdown mode to conserve resources. The field is set to zero, the magnet controller is turned off, the chamber heaters are turned off, and the chamber is sealed.

• **Wait** – Waits for specified conditions to be achieved, then delays a specified amount of time before continuing with sequence execution. Conditions that can be specified to wait for are temperature stability, field stability, and chamber state. This command is usually used immediately after another command in order to make sure the desired outcome of the first command is achieved before proceeding. For example:

  Set Temperature 77K at 10 K/min. Fast Settle
  Wait For Temperature. Delay 10 secs, No Action
  Measure Moment vs. Field…

This sequence will wait 10 seconds after the instrument has achieved temperature stability at 77 K before beginning a series of moment measurements at various magnetic fields. Specify, also, what the instrument should do if an error occurs while waiting for the specified conditions (no action, abort sequence, or shutdown instrument.)
3.4.5.2 MEASUREMENT COMMANDS

- **Log Data** – Records specified diagnostic data to a data file at a specified rate. No size limit is imposed on the data file generated, so the data file can get extremely large and difficult (or slow) to process. See Appendix B for more information on logging diagnostic data.

- **Sigma Log Data** – Records specified diagnostic data to a data file at a specified rate. This command is similar to the Log Data command, except that it allows you to record statistics such as a running average and standard deviation for each data item, in each data record. It may generate large data files with large header sections. See Appendix B for more information on logging diagnostic data.

- **Measurement Option Commands** – If a measurement option is active, an additional branch will be present populated with sequence measurement commands. See the appropriate option manual for instructions on how to use these commands.

3.5 Graphing Data Files

The graph view is the default for viewing data files. Any data file with one or more data records may be opened in a graph view. The appearance of graph views may be manipulated extensively to aid data analysis.

Open a data file to graph by clicking “Open Data File,” by selecting “File > Open > Datafile,” or on the control center click “View” to open the current data file.

3.5.1 Data Selection and Plot Axes

- Change the plot axes by selecting “Graph > Data Selection…” or right-click in an open graph window and select “Data Selection…”

- The axes may be assigned any label for which data exists in the data file.

- Up to four vertical axes may be displayed on separate plots in the same graph window, but all plots in the graph window must share the same horizontal (x) axis.

- When auto-scaling is selected for all axes, the plot axes will be rescaled each time new data is written to the data file so that all data is displayed. This helps optimize data viewing as data is being collected.

- Quickly auto-scale the axes by right clicking in the graph window and selecting “Auto Scale All Plots.”

- Use the “>>>” button to add custom axis labels and to change the axis scaling multiplier by factors of 10.

- Use the “Filter…” button to plot only records with data that falls within a specified range. For example, specify a range for moment standard error to hide data with a large standard error (i.e. noisy data.).
The “OK” button applies the changes to the graph window and closes the Data Selection dialog. The “Apply” button applies the changes to the graph window without closing the dialog. The “Cancel” button closes the Data Selection dialog without making any changes to the graph window.

3.5.2 Plot Appearance

- Change the appearance of each plot by selecting “Graph > Appearance > Plot 1” (or “… Plot 2,” etc.) or right-click the plot you want to change and select “Appearance.”
- Turn horizontal and vertical grid lines on and off with this dialog.
- Choose between markers on each data record, lines between each data record, or both markers and lines. The lines shown can be limited to only those in the positive or negative x directions using the “>>>” button.
- Check “Apply to All Plots” to apply the appearance settings to all plots in the graph window.

Figure 3-12. Graph Data Selection Dialog (on graph: right-click to Data Selection…)

Quantum Design

PPMS DynaCool User’s Manual, 1307-110, Rev. D1
November 2017

3-17
3.5.3 Template and Graph Files

Groups of graph view settings may be saved in template files (.tpl) and applied to other data files so the graph view of each data file will look similar. The settings saved in template files include all settings in the Data Selection and Plot Appearance dialogs. This feature helps view many different data files in the same graphic format. The settings are specific to files a given type, so applying a template file from a Log Data file to a VSM Data File will yield unexpected results.

A graph file (.gph) is a template file that MultiVu automatically applies to the data file (.dat) with the same name whenever the data file is opened in graph view. You may save template files as graph files (.gph), but it is not necessary to do so. MultiVu automatically saves a graph file for each data file whenever all graph views are closed so that the graph view of the data file will look the same next time it is opened.

- To save a template file, format the graph view as desired, then:
  - Select “File > Save Template”
  - OR
  - Select “Graph > Save Template”
  - OR
  - Right-click the graph view window and select “Save Template”

Then specify the path and file name for the template file. (Specify “Graph Files (.gph)” in the “Save as type:” box to save the template as a graph file. Be sure the file name you specify matches the data file you want the graph applied to in this case.)

- To apply a template to a data file, select “Graph > Apply Template…” (or right-click the graph view and select “Apply Template…” ) Then locate the template or graph file you want to use.

- “Graph > Restore Graph” applies the settings from the graph file to the graph window. This will undo any settings changed since last time the graph file was saved.
Chapter 3

3.5.4 Exporting Data Files

Many spreadsheet programs can read the standard .dat files DynaCool MultiVu generates. They have a comma-delimited format, but the files contain additional header information and may contain diagnostic data that complicates your data analysis or communication with collaborators. To export data files, or subsets of the data in a data file, do the following:

- Select a graph view of the data file you want to export.
- Select the menu item “File > Export…”
- Make sure “Data File” specifies the file you want to export. You can browse to a different data file if desired.
- Designate the path and file name of the exported file to write under “Export File.”
- Under “Destination File Format,” choose which character will separate data items in the exported file: tab, comma, or space.
- Choose whether you want column headers (column labels), full headers, or no headers.

With full headers, the file format must be comma delimited. All of the header information at the beginning of the data file will be written to the new file, including sample properties, software revision, and other information used by MultiVu. This header information will appear at the beginning of the exported data file and may not be easily imported by other programs. This option is used to keep the existing MultiVu data file format but export a subset of the data.
3.6 Temperature, Magnet, and Cryostat Services

The Temperature, Magnet, and Cryostat services run as Windows services in the background. While they can be started and stopped manually, normally they start automatically when the computer is started and remain running continuously in the background even if MultiVu is not running. Any temperature, field, or cryostat operation requested by MultiVu is controlled by one of these services. For example, if you enter a new temperature set-point into MultiVu, the request is passed to the Temperature Service which configures and manages the appropriate hardware components. While the services do not have a user interface, their operation is indicated by the icon located in the Windows tool tray in the lower right of the screen. Double-click this icon to open the Service Control utility (see Figure 3-15). This utility allows you to monitor whether the services are running or stopped, and to start or stop the services. Closing this utility does not stop the services.

If Windows User Account Control is enabled, then the Service Control utility must have administrator rights in order to start and stop services. (The utility can always monitor the services.) To do this:

- Right-click the icon in the Windows tool tray and select "Exit"
- Right-click on ServiceControl.exe (located at C:\QDDynaCool\Tools\) and select "Run as administrator".

- Click “Select Data” to specify which data items to export.
  - Available data items are listed on multiple tabs.
  - Check the box next to data items to write them to the export file.
  - Specify the order of the data columns in the export file by entering numbers in the “Col Order” boxes.
  - To exclude data that falls outside a certain range, check the “Select Range” box and specify the range of data to keep.
- Click “Export” to write the selected data to the exported file. You will see a confirmation dialog when the operation is complete.
Theory of Operation

4.1 Overview

This chapter describes the functional subsystems of PPMS DynaCool. The information in this chapter is not necessary for normal use of DynaCool, but will help you understand the underlying principals of the system’s operation. The subsystems and their respective sections are:

- **Section 4.2: Cryostat Control System**: maintains cryostat components at appropriate temperatures for normal operation.
- **Section 4.3: Chamber Temperature Control System**: controls the temperature of the sample chamber and sample puck contained inside it. Also provides cooling and heating for insert probes such as the Helium-3 Refrigerator and Dilution Refrigerator.
- **Section 4.4: Magnetic Field Control System**: controls the magnetic field at the sample location.
- **Section 4.5: Chamber Atmosphere Control System**: controls the atmosphere inside the sample chamber. Typical states are vented (~ 760 Torr of helium gas), purged (~ 1 Torr of helium gas), and high vacuum.
- **Section 4.6: Case Vacuum System**: prepares and maintains proper cryostat vacuum to allow the cryostat to achieve low temperatures.

The subsystems interact in many ways, and even share components. Nonetheless, it is helpful to break the system down into subsystems in order to understand their operation.

4.2 Cryostat Control System

The Cryostat Control System is responsible for keeping the cryostat components at the correct temperatures to allow normal operation of the rest of the subsystems. Figure 4-1 shows a diagram of the components described in this and the next two sections.
Figure 4-1. The DynaCool Cryostat showing the components of the Cryostat Control System, Chamber Temperature Control System, and Magnetic Field Control System. All items not shown in the box labeled “Pump Cabinet” are located on or in the cryostat.
4.2.1 Pulse Tube Cryocooler

The pulse tube cryocooler provides all of the cooling necessary for operation of PPMS DynaCool. No liquid cryogens are required. The pulse tube cryocooler has two cooling stages. The first stage typically runs at ~45 K, while the second stage typically runs at ~4.2 K. The components cooled by the two stages are listed below. These components are discussed in more detail later in this chapter.

**Cooled by First Stage:**
- Main radiation shield
- Annulus radiation shield
- First stage of cryopump
- Electrical wiring heat loads coming from room temperature
- Mechanical support heat loads coming from room temperature

**Cooled by Second Stage:**
- 4 K plate
- Superconducting magnet
- Helium gas and liquid for sample chamber cooling
- Second stage of cryopump
- Electrical wiring heat loads coming from first stage temperature
- Mechanical support heat loads coming from first stage temperature

Unlike many cryocooled systems, the pulse tube cryocooler in DynaCool is not mounted in vacuum and is not coupled to any cryostat components via solid links. Instead, the cryocooler resides in helium gas in a cryogenic tank usually called the bucket. The main radiation shield is cooled by conduction through a small gas gap to the first stage of the cryocooler, and other first stage components are cooled by solid contact to the main radiation shield. The 4 K Plate is cooled by contact with approximately 150 cc of liquid helium in the bottom of the bucket. Other second stage components are cooled by solid contact to the 4 K Plate. Heat loads from second stage components cause small amounts of liquid helium to evaporate from the bottom of the bucket. The evaporated helium then condenses on the second stage of the cryocooler and falls back onto the 4 K Plate, creating a classic thermosiphon.

4.2.2 Thermal Isolation

Like any cryostat, PPMS DynaCool contains components at different temperatures. DynaCool contains components ranging from room temperature to <1.8 K when the sample chamber is at its minimum temperature. Maintaining these temperature differences requires thermal isolation between cryostat components as described below.

Mechanical supports are engineered to provide mechanically robust linkages with minimal heat leak between different temperatures. Materials with low thermal conductivity are chosen for this reason. Also, heat loads from room temperature are intercepted by the main radiation shield (cooled by the cryocooler first stage) to prevent excessive heat load on the 4 K Plate.
Components that are not in mechanical contact are isolated from each other by the cryostat case vacuum, preventing heat transfer via gas conduction and convection. The Case Vacuum System is described in section 4.6.

The second stage components, at ~ 4.2 K, are protected from room temperature thermal radiation by the main radiation shield. Room temperature radiation is absorbed by the main radiation shield, and the resulting heat load is conducted through the shield and then to the first stage of the pulse tube cryocooler. The radiation heat load on the main radiation shield is reduced by wrapping it in reflective multi-layer insulation.

The sample chamber and cooling annulus that surrounds it vary in temperature from < 1.8 K to 400 K. Because the cooling annulus is inside the bore of the superconducting magnet, it would present a very large radiation heat load on the magnet when the chamber is at 400 K. In order to prevent this, the annulus radiation shield surrounds the cooling annulus without touching either the annulus or superconducting magnet bore. The annulus radiation shield is connected to the main radiation shield. Thermal radiation from the cooling annulus that shines on the annulus radiation shield is conducted up the annulus shield to the main shield, and from there to the first stage of the pulse tube cryocooler. This maintains the annulus radiation shield at low enough temperature (< 100 K) that it does not present a significant radiation heat load to the magnet bore.

### 4.2.3 Monitoring and Control

In order to monitor and control the cryostat, DynaCool includes three cryostat thermometers and two cryostat heaters (an additional heater on the cryopump is discussed in section 4.5):

**Thermometers:**

- **First stage thermometer:** monitors the temperature of the main radiation shield. This temperature appears in the Cryostat Monitor as “Shield” and in MultiVu Log Data as “1st Stage Temp (K)”. Reads ~ 45 K when the system is cold.

- **Second stage thermometer:** monitors the temperature of the 4 K Plate. This temperature appears in the Cryostat Monitor as “4K Plate” and in MultiVu Log Data as “2nd Stage Temp (K)”. Reads ~ 4.2 K when the system is cold.

- **Magnet thermometer:** monitors the temperature of the magnet. This temperature appears in the Cryostat Monitor as “Magnet” and in MultiVu Log Data as “Magnet (K)”. In addition, the MultiVu status bar displays the magnet temperature below the cryostat status. Typically reads <0.1 K warmer than the second stage thermometer when the system is cold and magnet is not charging. It may read much warmer during magnet charging.

**Heaters:**

- **First stage heater:** applies heat to the main radiation shield. This heater power appears in MultiVu Log Data as “1st Stage Power (W)”.

- **Second stage heater:** applies heat to the 4 K Plate. This heater power appears next to the “4K Plate” temperature in the Cryostat Monitor and in MultiVu Log Data as “2nd Stage Power (W)”.

When the system is cold, the first stage heater is off, and the second stage heater is used to control the second stage thermometer at 4.2 K. This temperature maintains ~ 1 atmosphere pressure above the liquid in the bucket in order to drive helium flow for sample chamber temperature control. The bucket pressure is reported in MultiVu Log Data as “Tank Pressure (Torr)”.

During the Warm Up operation, the first and second stage heaters are used to rapidly warm the first and second stage to 300 K.
These thermometers and heaters are all controlled and read out by the cryostat controller electronics, located in the pump cabinet. The Cryostat Service (see chapter 3) orchestrates the control of the cryostat. The Cryostat Service receives requests for cryostat modes (such as Startup), then sends commands to the Cryostat Control Electronics to achieve the desired results. The Cryostat Service also monitors the system when it is cold in order to ensure proper operation.

4.2.4  Startup Operation

The Cryostat Control System is completely automated by the DynaCool software. Therefore, starting up, or “cooling down” the system from a room temperature state is accomplished simply by pressing the “Startup…” button in the Cryostat Monitor. The DynaCool software then performs the operations described below. These operations involve systems described later in this chapter.

- Purge cryostat vacuum case with air to remove any residual helium gas.
- Purge circulation loop with helium and charge to > 1 atmosphere with helium gas.
- Regenerate the cryopump.
- Start the pulse tube cryocooler to cool the system from room temperature to operating temperature.
- Wait for the 4K Plate to get cold enough to condense helium.
- Meter helium gas into the bucket to condense about 150 cc in the bucket.
- Start 4K Plate temperature control, helium circulation for sample chamber cooling, and sample chamber temperature control.
- DynaCool is ready to use.

The startup operation typically takes < 16 hours for a system equipped with a 9 T magnet.

4.3  Chamber Temperature Control System

This section describes how the chamber temperature is controlled and measured. Figure 4-1 shows the major cryostat components described in this section.

4.3.1  Sample Chamber Thermometers and Heaters

The DynaCool Temperature Control System controls the temperature of the isothermal region of the sample chamber. The isothermal region is constructed of high-conductivity copper in order to minimize thermal gradients, providing a thermally uniform region for the sample environment. The puck interface is located at the bottom of the isothermal region, inside the sample chamber. On the outside of the sample chamber, the block thermometer is tightly coupled to the metal of the puck interface. This ensures that the block thermometer is at the same temperature as the puck, even when the block temperature is slewing at maximum rate.
The block heater is located below the puck interface. Using a tight feedback loop, the block heater controls the temperature of the block thermometer at the user-requested set point. The heater power balances a bias of cooling provided by helium gas flow as described in section 4.3.2.

The block heater is also used for controlled temperature ramps and rapid warming of the sample chamber.

In addition to the block thermometer and heater, there are two other thermometer-heater pairs on the sample chamber. One pair is the neck thermometer and neck heater located just above the isothermal region. The other pair is the high neck thermometer and high neck heater, located approximately at the vertical center of the sample chamber. Each of these pairs is used in a feedback configuration to reduce thermal gradients in the sample chamber. After rapid warming of the block from low temperature to room temperature, the lower and middle sections of the sample chamber would normally be cold for > 1 hour. The neck and high neck thermometer-heater pairs are used to keep the lower and middle sections of the sample chamber close to the block temperature during warming.

The high neck thermometer is also used to determine when the upper part of the sample chamber is cold enough for the system to enter low temperature mode as described in section 4.3.2.3.

### 4.3.2 Helium Flow and Circulation Loop

The Circulation Loop provides cooling helium flow to the DynaCool sample chamber. As shown in Figure 4-1, the circulation loop is made up of the cooling annulus, annulus pumping line, circulation pump, bypass and circulation/exhaust valves, return gas line, dump tanks, bucket, counter-flow heat exchanger, mass flow controller, impedance, and connecting tubes in the cryostat.

The dump tanks (located in the cryostat enclosure) provide a buffer volume, limiting pressure fluctuations when small amounts of helium condense and evaporate due to varying heat loads on the 4 K plate.

The circulation loop has four common operating modes:

- **Circulating.** In this mode the circulation pump is running, the bypass valve is closed, the circulate/exhaust valve is set to circulate, and the fill valve is closed. This is the mode used for normal temperature control.

- **Pumping.** In this mode the circulation pump is running, the bypass valve is open, the circulate/exhaust valve is set to exhaust, and the fill valve is closed. These settings enable the circulation pump to evacuate the entire circulation loop and exhaust its contents to the room.

- **Sealed.** In this mode the circulation pump is off, the bypass valve is open, the circulate/exhaust valve is set to circulate, and the fill valve is closed. This state is used while the system is cooling down and when it is shut down.

- **Venting.** In this mode the fill valve is open, venting helium into the circulation loop. This operation can be performed without circulation (during the loop purge and loop fill at room temperature) or with circulation (during the condense operation).

The DynaCool sample chamber resides inside the annulus tube as shown in Figure 4-1. The space between the sample chamber and annulus tube is called the cooling annulus. When the circulation loop is set to Circulating, helium flows up the cooling annulus in order to cool the sample chamber and provide a bias of cooling power for temperature control. The cooling helium flow is driven by the pressure difference between the cooling annulus and the bucket. The cooling annulus is maintained at moderate vacuum by the circulation pump. The bucket is maintained near 1 atmosphere by controlling the 4 K plate at 4.2 K as discussed in section 4.2.3. The exhausted helium from the circulation pump is returned to the bucket, where it is cooled by the cryocooler and reused for sample chamber cooling.
Two cooling flow modes are available in DynaCool: main flow (through the counter-flow heat exchanger) and low temperature flow (through the impedance). In addition, the circulation loop has special modes that allow it to be charged with clean helium during system startup. All of these modes are discussed below.

4.3.2.1 LOOP PURGE DURING SYSTEM STARTUP

During system startup, the circulation loop is purged with clean helium. To do this, the gas handling system is first configured so that the circulation pump evacuates the entire circulation loop and the outlet of the circulation pump is exhausted to the room (circulation pump on, bypass valve open, circulation/exhaust valve exhausting, and helium fill valve closed). Then the circulation loop is charged with clean helium from the supply bottle (circulation pump off, bypass valve open, circulation/exhaust valve circulating, and helium fill valve open). These steps are performed three times during the startup operation in order to ensure a clean charge of helium in the circulation loop.

4.3.2.2 MAIN FLOW

In order to circulate helium for chamber cooling, the circulation loop is configured with the circulation pump turned on, the bypass valve closed, the circulation/exhaust valve set to circulation, and the helium fill valve closed.

The main flow system provides up to 5000 standard cc/minute (sccm) of ~ 4.2 K helium gas to cool the sample chamber. Main flow starts as 4.2 K helium gas in the bucket. The gas then flows up the counter-flow heat exchanger (CFE), through the mass flow controller, back down the CFE, through connecting tubing, and into the cooling annulus. The flow then runs through the annulus pumping line to the circulation pump, then through the return gas line back to the bucket. The mass flow controller controls the main flow rate from 0 to 5000 sccm. The flow read-back value is reported in MultiVu Log Data as “CFE Flow (SCCM).” Also, a rough measure of the circulation pump outlet flow is reported as “Pump Flow (uncal SCCM).”

When the chamber temperature is stable, the main flow is selected to provide adequate cooling bias for the thermometer-heater feedback loop. Typically the main flow is a few hundred sccm when the chamber is stable, and the annulus pressure is < 10 Torr.

When the chamber temperature is ramping down quickly (> 5-10 K/minute), the main flow is typically set to its maximum value of 5000 sccm and the annulus pressure is ~ 50 Torr due to the high flow through the circulation pump. When combined with low temperature mode discussed in the next section, DynaCool typically achieves cooling from 300 K to 1.9 K in < 40 minutes.

When the chamber temperature is ramping down more slowly, the main flow is set to intermediate values as required for the requested ramp rate. When the chamber temperature is ramping up, the main flow is set to a low value, typically 150 sccm.

4.3.2.3 LOW TEMPERATURE FLOW

In order to circulate helium, the circulation loop is configured as described in the previous section.

The low temperature flow system provides about 1000 sccm of ~ 1.7 K helium gas to cool the sample chamber when it is below about 10 K. In this mode, the main flow is set to zero and 4.2 K liquid from the bucket is expanded through the capillary flow impedance. The inlet of the impedance is at bucket pressure, about one atmosphere, and the outlet is at annulus pressure, about 10 Torr. As the helium undergoes expansion in the impedance, some of it evaporates, resulting in an impedance outlet flow that is a mixture of liquid and gas at about 1.7 K. This mixture flows through connecting tubes to the bottom of the cooling annulus, also known as the pot.
In low temperature mode, a small amount of liquid helium accumulates in the bottom of the annulus. In order to achieve stable temperature control with high cooling power, DynaCool simultaneously controls the level of liquid in the bottom of the annulus and the flow rate of gas in the cooling annulus. This control is achieved using a liquid level sensor in the cooling annulus, a heater on the impedance, and a heater on the pot. These values are reported in MultiVu Log Data as “Pot Liquid Level (%),” “Impedance Power (W),” and “Pot Power (W).”

DynaCool enters low temperature mode when cooling at 10 K. Once in low temperature mode, the system enters main flow mode when the temperature goes above 16 K.

In order to avoid excessive heat load conducted down the sample chamber, DynaCool will not enter low temperature mode if the high neck temperature is above 220 K. If the system reaches 10 K and the high neck temperature is > 220 K, then high main flow is maintained in order to quickly cool the high neck to 220 K before the system enters low temperature mode.

4.3.3 Temperature Control Electronics and Software

Three electronic modules are involved in temperature control:

- **Temperature Control Module** (Located in CAN module bay). The Temperature Control Module (TCM) reads out the block thermometer, neck thermometer, and high neck thermometer. The TCM also provides heater current to the block heater, neck heater, and high neck heater based on feedback temperature control using thermometer readings.

- **Cryostat Control Electronics** (Located in pump cabinet). The cryostat controller electronics control the mass flow controller for main flow, the impedance heater, and the pot heater. The Cryostat Control Electronics also turn on and off the circulation pump and control solenoid valves as needed.

- **Cryostat Utility Controller** (Located on cryostat top plate). The cryostat utility controller reads out the liquid level sensor located in the bottom of the cooling annulus.

Temperature control is orchestrated by the Temperature Service. The Temperature Service receives temperature set points and then sends commands to the temperature control electronics to achieve the desired result.

4.3.4 Temperature Values and Configurations

There are several temperature values involved in sample temperature control and sample temperature measurement that are reported in MultiVu Software, Option Software, and Data Files. The meaning of these temperatures depends on the configuration of the temperature control system. The following two sections describe these values and the different configurations of the DynaCool temperature control system.

4.3.4.1 TEMPERATURE VALUES REPORTED IN SOFTWARE AND DATA FILES

**Block Temperature.** This value always reports the temperature read by the block thermometer, which is mounted to the outside of the puck interface at the bottom of the sample chamber. It is reported in MultiVu Log Data as “Bock Temp (K).”
Control Temperature. This value reports the temperature that base DynaCool temperature software is controlling, using the basic sample chamber temperature control in the range 1.8 – 400 K. If you are not using an option which includes a control thermometer, then the Control Temperature is the Block Temperature. Some options, such as the Vibrating Sample Magnetometer, include a control thermometer. In this case the Control Temperature is the value from this thermometer (e.g. the coil thermometer for Vibrating Sample Magnetometer). This Control Temperature is reported in MultiVu Log Data as “Control Temp (K)”. Also, the Log Data item “Control Therm (ID)” reports an identification number for the control thermometer. A value of 643 indicates the block thermometer. Other values indicate that Option Software has configured the system to use a different control thermometer.

Sample Temperature. This value reports the temperature that is being controlled to achieve the desired sample temperature. If no extended-range temperature option is active, this is the same as the Control Temperature. If an extended range temperature option such as Dilution Refrigerator is active, then this value is measured by an option-provided sample thermometer that is being controlled using a feedback loop implemented in Option Software, not base DynaCool temperature software. This value is reported in the MultiVu status bar and in Log Data as “Temp (K)”. Also, the Log Data item “Sample Therm (ID)” reports an identification number for the control thermometer. A value of 643 indicates the block thermometer. Other values indicate that Option Software has configured the system to use a different sample thermometer.

Measurement Temperature. This value is the temperature of the sample recorded in option data files with sample measurement results. In many cases, this value is the same as the Sample Temperature, and may be derived by averaging multiple readings of the Sample Temperature. In other cases, the Measurement Temperature is derived from option thermometer readings not displayed elsewhere. An example is Heat Capacity, where the Measurement Temperature is the average of the platform thermometer during the relaxation measurement.

4.3.4.2 TEMPERATURE CONTROL CONFIGURATIONS

DynaCool provides a configurable temperature control platform to allow a measurement option to control on a thermometer close to the sample and/or extend the temperature control range. The following control configurations are available:

Base Configuration. This configuration is used when no measurement option is active, or when the measurement option provides no additional thermometers. In this mode, the Measurement Temperature, Sample Temperature, Control Temperature, and Block Temperature all report the value of the block thermometer. Measurement configurations that use this mode include:

<table>
<thead>
<tr>
<th>Measurement Configuration</th>
<th>Control Thermometer</th>
<th>Sample Thermometer</th>
<th>Measurement Thermometer</th>
<th>Control Therm (ID)</th>
<th>Sample Therm (ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electro-Transport or Resistivity (1.8 – 400 K)</td>
<td>Block Thermometer</td>
<td>Block Thermometer</td>
<td>Block Thermometer</td>
<td>643</td>
<td>643</td>
</tr>
<tr>
<td>User measurements with no additional thermometer</td>
<td>Block Thermometer</td>
<td>Block Thermometer</td>
<td>Block Thermometer</td>
<td>643</td>
<td>643</td>
</tr>
</tbody>
</table>

Base Configuration with Measurement Option Thermometer. This configuration is used when the measurement option provides a thermometer close to the sample that is used to measure the sample temperature, but the control system does not use this thermometer. In this mode, the Sample Temperature, Control Temperature, and Block Temperature all report the value of the block thermometer. The Measurement Temperature reports the value of the measurement option thermometer. Measurement configurations that use this mode include:
**Option Temperature Control Configuration.** This configuration is used by measurement options that provide a control thermometer near the sample, and use the standard DynaCool temperature range (1.8 – 400 K). In this mode, the Measurement Temperature, Sample Temperature, and Control Temperature all report the value of the control thermometer provided by the option. Measurement configurations that use this mode include:

<table>
<thead>
<tr>
<th>Measurement Configuration</th>
<th>Control Thermometer</th>
<th>Sample Thermometer</th>
<th>Measurement Thermometer</th>
<th>Control Therm (ID)</th>
<th>Sample Therm (ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat Capacity (1.8 – 400 K)</td>
<td>Block Thermometer</td>
<td>Block Thermometer</td>
<td>Platform Thermometer</td>
<td>643</td>
<td>643</td>
</tr>
<tr>
<td>Thermal Transport</td>
<td>Block Thermometer</td>
<td>Block Thermometer</td>
<td>Hot and Cold Thermometer</td>
<td>643</td>
<td>643</td>
</tr>
</tbody>
</table>

**Extended Range Option Temperature Control.** This configuration is used by measurement options that provide a control thermometer near the sample, and provide temperature control outside the standard 1.8 – 400 K range. In this mode, the Measurement Temperature and Sample Temperature both report the value of the extended range control thermometer. The Control Temperature is either the Block Temperature or the value read by a measurement option thermometer. Measurement configurations that use this mode include:

<table>
<thead>
<tr>
<th>Measurement Configuration</th>
<th>Control Thermometer</th>
<th>Sample Thermometer</th>
<th>Measurement Thermometer</th>
<th>Control Therm (ID)</th>
<th>Sample Therm (ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vibrating Sample Magnetometer (1.8 – 400 K)</td>
<td>VSM Coil Thermometer</td>
<td>VSM Coil Thermometer</td>
<td>VSM Coil Thermometer</td>
<td>968</td>
<td>968</td>
</tr>
<tr>
<td>AC Measurement System</td>
<td>ACMS Coil Thermometer</td>
<td>ACMS Coil Thermometer</td>
<td>ACMS Coil Thermometer</td>
<td>406</td>
<td>406</td>
</tr>
<tr>
<td>Electro-Transport or Resistivity with Horizontal Rotator</td>
<td>Rotator Thermometer</td>
<td>Rotator Thermometer</td>
<td>Rotator Thermometer</td>
<td>1173</td>
<td>1173</td>
</tr>
<tr>
<td>Torque Magnetometer</td>
<td>Rotator Thermometer</td>
<td>Rotator Thermometer</td>
<td>Rotator Thermometer</td>
<td>1173</td>
<td>1173</td>
</tr>
<tr>
<td>User measurements with additional control thermometer</td>
<td>User Thermometer</td>
<td>User Thermometer</td>
<td>Depends on User Program</td>
<td>User choice</td>
<td>User choice</td>
</tr>
</tbody>
</table>
### Measurement Configuration

<table>
<thead>
<tr>
<th>Control Thermometer</th>
<th>Sample Thermometer</th>
<th>Measurement Thermometer</th>
<th>Control Therm (ID)</th>
<th>Sample Therm (ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vibrating Sample Magnetometer with Oven</td>
<td>Coil Thermometer</td>
<td>Oven Stick Thermocouple</td>
<td>Oven Stick Thermocouple</td>
<td>968</td>
</tr>
<tr>
<td>Electro-Transport or Resistivity with Helium-3</td>
<td>Block Thermometer or Helium-3 Sample Thermometer</td>
<td>Helium-3 Sample Thermometer</td>
<td>Helium-3 Sample Thermometer</td>
<td>643 or 655</td>
</tr>
<tr>
<td>Electro-Transport or Resistivity with Dilution Refrigerator</td>
<td>Block Thermometer</td>
<td>Dilution Refrigerator Sample Thermometer</td>
<td>Dilution Refrigerator Sample Thermometer</td>
<td>643</td>
</tr>
</tbody>
</table>

**Extended Range Option Temperature Control with Additional Measurement Option Thermometer.** This configuration is used when the measurement option provides a thermometer close to the sample that is used to measure the sample temperature, and an additional option is providing extended range temperature control. In this mode, the Sample Temperature reports the value of the extended range control thermometer. The Control Temperature is either the Block Temperature or an additional option thermometer. The Measurement Temperature reports the value of the measurement option thermometer. Measurement configurations that use this mode include:

<table>
<thead>
<tr>
<th>Measurement Configuration</th>
<th>Control Thermometer</th>
<th>Sample Thermometer</th>
<th>Measurement Thermometer</th>
<th>Control Therm (ID)</th>
<th>Sample Therm (ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat Capacity with Helium-3</td>
<td>Block Thermometer or Helium-3 Sample Thermometer</td>
<td>Helium-3 Sample Thermometer</td>
<td>Platform Thermometer</td>
<td>643 or 655</td>
<td>655</td>
</tr>
<tr>
<td>Heat Capacity with Dilution Refrigerator</td>
<td>Block Thermometer</td>
<td>Dilution Refrigerator Sample Thermometer</td>
<td>Platform Thermometer</td>
<td>643</td>
<td>402</td>
</tr>
</tbody>
</table>

---

1 The Helium-3 Refrigerator sets the block thermometer as the control thermometer in low temperature control modes, and sets the Helium-3 sample thermometer as the control thermometer in high temperature control modes.
4.4 Magnetic Field Control System

The magnetic field control system consists of the superconducting magnet and leads, the magnet controller, software, and the magnet shield.

4.4.1 Magnet and Leads

The magnetic field in DynaCool is generated by a superconducting solenoid mounted in the cryostat vacuum space. The magnet generates a vertical magnetic field. Typical currents at maximum field are 55 A for a 9 Tesla magnet and 120 A for a 14 Tesla magnet. While most magnets are cooled by liquid or gaseous helium, the DynaCool magnet is cooled by solid conduction. The magnet is cooled by solid contact to the 4 K plate. Figure 4-1 shows how the magnet is directly connected to the 4 K Plate.

The DynaCool magnet does not have a superconducting switch. Rather, the magnet controller is directly connected, via magnet leads, to the superconducting solenoid. The magnet leads are designed to present a very small heat load to the 4 K Plate, so heat loads from magnet currents do not affect temperature control operation. The heat load to the Main Shield is more substantial, but easily handled by the large cooling power at the cryocooler first stage.

The magnet leads inside the cryostat consist of three stages:

- The section between room temperature and the Main Shield, which is constructed of copper wire. The design minimizes the total heat load on the cryocooler first stage considering solid conduction and joule heating at maximum current.
- The section between the Main Shield and 4 K Plate, which is constructed of high temperature superconductor, eliminating joule heating.
- The section between the 4 K Plate and the magnet, which is constructed of NbTi alloy, also eliminating joule heating.

Low thermal resistance, but electrically isolating thermal anchors cool the magnet leads at the Main Shield and 4 K Plate in order to make sure that the high temperature superconductor and NbTi sections are superconducting and to minimize heat load to the next stage.

4.4.2 Magnet Controller and Software

The DynaCool magnet controller is located in the center rear portion of the pump cabinet. Depending on magnet model, a controller capable of sourcing either 60 or 120 A is provided. Due to an inherently 4-quadrant design and analog current feedback, the system is able to achieve linear field ramps with no discontinuity or kink at zero field and negligible overshoot when stabilizing.

Magnet control is orchestrated by the Magnet Service in DynaCool. Besides sending field set points to the controller, the Magnet Service monitors the magnet for quenches and over-temperature conditions. If such a condition occurs, the Magnet Service will instruct the Magnet Controller to discharge the magnet, and the Cryostat Service will attempt to cool the magnet as quickly as possible.
4.4.3 Magnetic Shielding

The DynaCool Cryostat resides inside an enclosure that also functions as a magnet shield. The enclosure is constructed of steel in order to reduce the field experienced outside the enclosure. The extent of shielding depends on magnet model, so see your system specifications for information about stray fields outside the enclosure.

4.4.4 Magnetic Field Accuracy, Uniformity, and Magnet Reset

DynaCool reports the magnetic field as the measured magnet current multiplied by a calibration factor determined at the factory for your magnet. (This factor is stored in the cryostat SROM.) The system does not take magnet relaxation or trapped flux into account. For information on the resulting field remanence, see your system specifications.

The uniform region of the magnetic field is centered 4.05 cm (1.6 inches) above the top surface of standard sample puck. The uniformity of the magnetic field depends on the magnet model, so see your system specifications for more information about uniformity.

4.5 Chamber Atmosphere Control System

Many experiments carried out in DynaCool require control of the atmosphere present in the sample chamber. Any experiment that involves low temperatures requires an atmosphere that will not freeze or condense on the sample and other experimental hardware. Some experiments benefit from the thermal uniformity provided by exchange gas, while others require thermal isolation provided by high vacuum. DynaCool meets all of these needs with its chamber atmosphere control system. In addition, this system enables DynaCool to pump out prepare the cryostat vacuum case prior to system startup, as described in section 4.6.
Figure 4-2. The DynaCool Cryostat showing components of the Chamber Atmosphere Control System and Case Vacuum System. All items not shown in the box labeled "Pump Cabinet" are located on or in the cryostat. Refer to Figure 4-1 for details about cryostat components not labeled in this figure.
The chamber atmosphere control system consists of the following components, most of which are shown in Figure 4-2.

- **Chamber/Case Pump**: Evacuates the chamber to pressures as low as ~1 Torr.
- **Helium Vent Gas**: Vents chamber up to about 1 atmosphere with helium gas. The pressure of gas entering the chamber is controlled by the chamber regulator on the pump cabinet manifold. This regulator is set at the factory.
- **Cryopump**: Evacuates chamber to high vacuum when High Vacuum Valve is open. The first stage of the cryopump pumps condensable gasses such as air and water, which are present only as contaminants in the chamber. The second stage of the cryopump pumps the helium gas that is left behind after purging.
- **High Vacuum Valve**: Controls connection between chamber and cryopump. The state of this stepper motor-controlled bellows valve is stored in memory in the Cryostat Controller. When the Cryostat Controller boots up, it closes this valve to put it in a known state.
- **Chamber Isolation Valve**: Controls connection between chamber and chamber/case gas line. It is a normally closed solenoid valve.
- **Helium Vent Valve**: Controls connection between chamber/gas gas line and helium supply line. It is a normally closed solenoid valve.
- **Flush Valve**: Controls the connection between chamber/case pump and chamber/case gas line. It is a normally closed solenoid valve.
- **Chamber Vacuum Gauge**: Records the pressure in the sample chamber.
- **Cryopump Heaters**: Apply heat to cryopump in order to regenerate it.

With the exception of the Chamber Vacuum Gauge, all of these components are controlled by the Cryostat Control Electronics.

### 4.5.1 Chamber Operations

DynaCool supports several chamber operations, described below. It is important to note that any chamber operation involving pumping should be performed only when the sample chamber KF flange is sealed. Otherwise, the chamber will not be pumped down as desired during these operations.

- **Seal**: Sealing the chamber simply closes all valves, leaving the chamber atmosphere unchanged.
- **Purge and Seal**: Purging and sealing the sample chamber performs four cycles of pumping out most of the chamber gas and then filling it up with vent gas. Finally, the chamber is pumped down to a pressure that is appropriate for experiments that require exchange gas, about 10 Torr. Normally, you purge and seal the chamber at room temperature after installing a sample in order to clean out atmospheric contaminants introduced while the chamber was open.
- **Vent and Seal**: Venting and sealing the sample chamber fills the chamber with helium vent gas, and then seals the chamber. This operation is useful when you want to conserve vent gas, because vent gas will not flow out of the vent gas supply bottle once the vent valve is closed. You can use this operation before opening up the sample chamber at room temperature in order to change samples.
• **Pump Continuous.** This operation uses the chamber/case pump to evacuate the sample chamber. The flush and chamber isolation valves remain open and the pump remains on indefinitely.

• **Vent Continuous.** This operation, also known as flooding, fills the chamber with helium vent gas, and does not seal the chamber. Because the flow of vent gas is continuous, this operation minimizes the amount of air that enters the chamber. Be careful not to leave the system in this state for too long, because doing so will empty the helium supply bottle.

• **High Vacuum.** This operation uses the cryopump to pump a high vacuum, typically < 10^{-4} Torr, in the sample chamber. First, the chamber/case pump evacuates the sample chamber to < 5 Torr. Then the high vacuum valve is opened, exposing the sample chamber to the cryopump. The system declares high vacuum when the pressure gets below 5×10^{-3} Torr.

### 4.6 Case Vacuum System

The cryostat vacuum case must be maintained at high vacuum in order to thermally isolate components at different temperatures. DynaCool maintains its vacuum case without the need for user intervention or any high vacuum pumps. The case vacuum system consists of the following components, most of which are shown in Figure 4-2.

- **Chamber/Case Pump:** Evacuates case to ~ 2 Torr.
- **Flush Valve:** Controls the connection between chamber/case pump and chamber/case gas line. It is a normally closed solenoid valve.
- **Case Valve:** Controls connection between chamber/case gas line and vacuum case. It is a normally closed solenoid valve.
- **Air Vent Valve:** Allows air to be vented into the chamber/gas gas line and from there to the vacuum case when the case valve is open. It is a normally closed solenoid valve.
- **Charcoal Sorbs:** Adsorb gasses in vacuum case that are not removed by chamber/case pump.

In addition to these components, the chamber vacuum gauge is used to monitor the cryostat vacuum case pressure during some operations. The chamber isolation valve is open during these operations in order to connect the chamber to the chamber/case gas line.

#### 4.6.1 Case Vacuum Operation

During Startup (cooling down the cryostat), the vacuum case is prepared as follows:

- Vent the case to 600 Torr with air.
- Pump the case down to 50 Torr.
- Repeat the vent and pump cycle for a total of 3 cycles. This procedure removes any residual helium from the vacuum case. Helium is not removed by the charcoal sorbs until they achieve < ~15 K, so helium in the vacuum space can prevent proper cooling.
• Wait while other Startup operations occur.
• Resume pumping on the vacuum case.
• When the 1st and 2nd Stage temperatures are both < 250 K, the case is sealed. Typically the case pressure is < 2 Torr at this point.
• As the cool down commences, the charcoal sorbs adsorb remaining gasses, achieving the high vacuum condition required for normal cryostat operation.
CHAPTER 5

Maintenance and Servicing

5.1 Overview

This chapter describes the most common maintenance procedures needed to keep DynaCool running properly. Also consult measurement option manuals for maintenance of option hardware. Be sure to contact Quantum Design service if you ever have questions about system maintenance.

The DynaCool system is designed to operate with minimal maintenance for 20,000 hours (about two years). Quantum Design recommends that you have the DynaCool system serviced every two years. Some services must be performed only by a qualified Quantum Design representative. Contact your local Quantum Design representative to schedule the maintenance visit. The following sections describe various maintenance procedures you might need to perform on your DynaCool system.

5.2 Changing the Helium Gas Supply Cylinder

Periodically you will need to change the helium gas supply cylinder that is used to supply helium to DynaCool. It is recommended to monitor the gauge on the cylinder pressure regulator and to change the cylinder before it is completely depleted. This is because an empty bottle will interrupt normal chamber gas handling operations and other automated procedures, such as System Startup and possibly result in unpredictable behavior. For a standard K-size cylinder, Quantum Design recommends changing the cylinder when the pressure falls below 300 psi (2 MPa). It is not necessary to shut down or warm up the DynaCool system in order to change the Helium Cylinder.

The system requires standard laboratory-grade helium gas, 99.998% pure or better. Higher purity is not necessary for proper circulation loop operation, but it may be desirable if extremely clean vent and purge gas is needed for your particular experiments.

Follow the steps below to change the helium gas supply cylinder.

1. Close the needle valve. Use two 3/4-inch box wrenches or two adjustable crescent wrenches to disconnect the helium gas transfer hose from the supply cylinder at the double-sealing connector, shown in Figure 5-1. Use one wrench to hold the male fitting on the regulator fitting stationary while using the other wrench to loosen the female fitting. Only open the double-sealing connection – leave all the other joints sealed. Do not change the setting on the regulator.
2. Close the bottle valve and remove the regulator from the empty cylinder and connect it to the new cylinder. Make sure the cylinder fitting is tight and that the sealing surfaces of the fitting are clean and undamaged.

3. With the needle valve still closed, open the bottle valve on the new cylinder and leak-check the cylinder fitting using soapy water. Because a typical cylinder of gas will remain in service for an extended period, it is important to make sure the fittings are leak-tight. Even small leaks around the regulator fittings could result in most of the gas being lost rather than used in the system.

4. Before connecting the helium gas transfer hose to the new cylinder, purge the air from the regulator by installing and using the check-valve assembly that is supplied with the DynaCool system (see Figure 5-2). Open the needle valve to allow gas to flush for several seconds. If you can’t locate this fitting, then skip this step and then be sure to perform 3 or 4 chamber purge operations from MultiVu when you are finished with step 6.

5. Verify that the regulated pressure is set to 15-20 psi (0.10-0.14 MPa) before proceeding. Make adjustments as needed and open and close the needle valve to make sure the reading is consistent when closed.

6. Remove the check valve assembly and connect the helium supply hose at the double-sealing connector and open the needle valve.
5.3 Replacing the Scroll Pump Tip Seals (Varian SH110) Scroll Pump

Approximately every 6 months, it will be necessary to service the circulation pump by performing this tip-seal replacement procedure. This procedure can be performed on a maintenance schedule or when it is determined that the pump is in need of maintenance. This procedure can be performed when the system is warm or cold. Typically the annulus pressure is unusually high in low temperature mode when the tip seals are worn. The tip seals are the plastic sealing surfaces that create the seal between the stationary and moving scrolls.

Before beginning make sure you have all of the parts you need. These are available in the DynaCool Tip Seal Replacement Kit (Quantum Design part number 4307-041). You will also need a 9/64 hex socket key and an adjustable crescent wrench.

Figure 5-3. Pump exhaust filter assembly.
### 5.3.1 Replacing the Tip Seals on a Cold System

In order to replace the tip seals on a cold system, follow these instructions:

2. Follow the instructions in the Pump Maintenance utility to prepare the system for pump removal, and then remove the pump.
3. When prompted by the Pump Maintenance utility, clean the particulate filter. The particulate filter is part of the pump exhaust filter assembly removed from the pump exhaust (see Figure 5-3).
   a. Remove the two hex socket screws from the filter top (item 1).
   b. Pull the filter bottom off (item 2) while the filter assembly is in the upright position to avoid spilling the tip seal dust.
   c. Empty out the filter bottom and wipe clean. You can use some Isopropyl alcohol if needed to wipe the trap clean.
   d. Examine the radial o-ring on the trap top and make sure it is clean and free of defects. If needed, replace this o-ring with the replacement in the kit. Apply a small amount of M-grease to the new o-ring prior to installation.
   e. Press the filter bottom back in place and tighten the two hex socket screws.
4. When prompted by the Pump Maintenance utility, replace the tip seals.
   a. With the pump on a bench, follow the instructions provided for removing the old tip seals and installing the new ones. Make a note of the hours the pump has been running. There is a chronometer located near the power inlet. It is useful to log when the tip seals are replaced to predict when future tip seal replacement will be necessary.
5. Follow the rest of the instructions in the Pump Maintenance utility to reinstall the pump.

### 5.3.2 Replacing the Tip Seals on a Warm System

In order to perform tip seal maintenance on a warm system, follow these instructions:

1. Warm up the DynaCool system
   a. Press the warm up system button on the console and wait for the system to warm to room temperature. This takes 8-16 hours.
   b. Shut down the computer and power down the system by switching off the main breaker switch, located in the back of the cabinet.
2. Remove the Scroll pump from the System Cabinet.
   a. Remove the lower front panel and lower right side panel of the System Cabinet by pulling the bottom out away from the cabinet and lowering the tabs out of the slots at the top.
   b. Unplug the power cord from the pump and remove the hose connected to the pump inlet at the top KF-25 flange. Since the circulation system is under vacuum, you will notice a lot of air flowing into the system when the KF flange is removed. This is normal. (The next startup operation will evacuate and purge the loop automatically.)
   c. Remove the pump exhaust filter assembly from the pump exhaust port by unscrewing the VCO nut. The pump exhaust port is located on the side of the pump housing facing the rear of the system cabinet. The correct VCO nut to loosen is shown as item 8 in Figure 5-3.
d. Remove the 4 1/4-20 nuts holding the SH110 in place and remove the pump from the cabinet.

3. Replace the tip seals.
   a. With the pump on a bench, follow the instruction provided for removing the old tip seals and installing the new ones. Make a note of the hours the pump has been running. There is a chronometer located near the power inlet. It is useful to log when the tip seals are replaced to predict when future tip seal replacement will be necessary.

4. Clean out the particulate filter. The particulate filter is part of the pump exhaust filter assembly removed from the pump exhaust (see Figure 5-3).
   a. Remove the two hex socket screws from the filter top (item 1).
   b. Pull the filter bottom off (item 2) while the filter assembly is in the upright position to avoid spilling the tip seal dust.
   c. Empty out the filter bottom and wipe clean. You can use some Isopropyl alcohol if needed to wipe the trap clean.
   d. Examine the radial o-ring on the trap top and make sure it is clean and free of defects. If needed, replace this o-ring with the replacement in the kit. Apply a small amount of M-grease to the new o-ring prior to installation.
   e. Press the filter bottom back in place and tighten the two hex socket screws.

5. Reinstall the pump into the System cabinet.
   a. Place the pump back on the 4 vibration mounts and secure with the lock washers and nuts you removed in step 2.
   b. Re-connect the pump inlet hose to the pump inlet. Make sure the KF-25 o-ring is clean before making the joint.
   c. Re-connect the exhaust filter assembly to the pump exhaust. Make sure the VCO o-ring is clean before making this joint. The VCO nut should be turned 1/8 of a turn past finger tight to make sure it does not come loose.

---

5.4 Inspecting and Maintaining O-rings

O-rings require regular inspection and lubrication. The only O-ring that you regularly encounter in DynaCool is the one on the sample chamber KF flange. Be sure to maintain this O-ring as described below. In addition, if you service any other parts of the system, be sure to inspect and lubricate O-rings you encounter during servicing as well.

Whenever you see an O-ring, take the time to visually inspect it. If it appears dirty, clean it with a lint-free cloth. Replace O-rings that are cracked. If the O-ring is dry, apply a small amount of silicone vacuum grease to it. Apply only a thin film of grease to the O-ring. Do not apply so much grease that more than a film is visible.

Also inspect the metal surfaces that mate with the O-ring, and clean them if necessary. Take care not to use sharp instruments on O-rings or the mating surfaces as it could result in damage. Keeping O-ring seals in good working order prevents leaks that could cause malfunction or damage to the instrument. Leaks at the sample chamber KF flange can cause the formation of an ice plug in the sample chamber, which results in dangerous and damaging pressure during warming. Be sure to maintain this often encountered O-ring.
5.5 Replacing Fuses and Resetting Breakers

The system has several user accessible fuses and breaker-switches. In case you encounter situations where a fuse blows or a breaker opens, contact your Quantum Design service representative to investigate the root cause of the problem.

If you replace any blown fuses, be sure to use only the values described here. Use of other values creates electrical hazard and may damage your system.

This section does not discuss fuses and breakers in equipment supplied by other manufacturers, such as the helium compressor and vacuum pump. Refer to labels on such equipment and separate documentation for more information.

5.5.1 Pump Cabinet Power Input Breakers

There are five breakers on the back of the pump cabinet, all controlling 200-230 VAC power. In the event of an over-current condition, one or more of these breakers may switch to the off position. They may be switched back to the on position like a normal rocker switches. The breakers on the back of the pump cabinet are:

- **MODULE BAY AND COMPUTER:** This 10 Amp breaker switches the power to the outlets in the computer bay and also the AC power line supplying the module bay. Do not use this breaker to turn off the power to the module bay since you will lose power to the computer. Instead use the power switch on the back of the module bay for this (see Figure 2-4).

- **MAG PWR 12 A:** This 12 Amp breaker switches power to the large IEC C19 connector below the magnet controller bay. This is usually used only for 14 T DynaCool systems.

- **MAG PWR 10 A:** This 10 A breaker switches power to the IEC C13 connector inside the magnet controller bay. This is usually used for 9 T DynaCool systems.

- **CABINET:** This 10 A breaker switches the power to the pumps and gas handling instruments inside the pump & gas-handling bay in the bottom of the cabinet. It also switches power to the control electronics located in the side of the pump cabinet. This breaker should be off when opening the side panel on the cabinet.

- **MAIN PWR:** This 30 Amp breaker switches power to all components of DynaCool, except the compressor power.

5.5.2 Pump Cabinet External 24 V Breakers

There are two breakers located on the back of the pump cabinet under the label **EXTERNAL** (see Figure 2-7). These breakers switch +/- 24 VDC power to the **CAN OUT** connector labeled JQQ-3. Normally there is only a CAN termination dongle connected to JQQ-3.

When one of these breakers trips, a white section appears. Push on the lever near the white section to reset the breakers.
5.5.3 Cryostat Controller Board Fuses

The cryostat controller board utilizes four fuses. To access these fuses, first shut down the computer, power down the entire system using the **MAIN PWR** breaker, and then disconnect the system from the wall power outlet. Then remove the right panel from the pump cabinet by removing the two screws near the back of the panel and then pulling on the panel to disconnect the ball studs that hold the panel onto the cabinet. The fuses on the cryostat controller PC board are:

- F1 and F2: 5 Amp, 20 mm delay type. These fuses control +/- 24 VDC power to the controller board.
- F3 and F4: 5 Amp, 20 mm delay type. F3 controls 200-230 VAC power to the circulation pump and F4 controls 200-230 VAC power to the chamber/case pump.

5.5.4 Magnet Controller Fuses and Breakers

The magnet controller on 9 T DynaCool systems contains two 8 Amp, 20 mm delay type fuses in its power entry module. There is also a switch (not a breaker) on the power entry module. Before servicing these fuses, turn this switch to the off position and disconnect the power cord from the magnet controller.

The magnet controller on 14 T DynaCool systems has a 16 Amp breaker-switch in its power entry module. There are not fuses in the power entry module on 14 T systems.

Normally the switch on the magnet controller is left in the “On” position and the **MAG PWR 10 A** or **MAG PWR 12 A** pump cabinet power input breaker is used to turn the magnet controller on and off.

5.5.5 CAN Module Bay Fuses

Before servicing any of these fuses, turn the CAN module bay power off using the switch on the back panel, and disconnect the power cord.

The power entry module on the rear panel of the CAN module bay contains two 6.3 Amp, 20 mm delay type fuses. There is also a switch (not a breaker) on the power entry module.

The rear panel of the CAN module bay houses four additional fuses, F1, F2, F3, and F4. All four of these fuses are 5 Amp, 3AG standard fuses. Fuses F1 and F2 control +/- 24 VDC power to JQR-1, JQR-2 on the rear panel of the module bay and JQR-9 on the front panel of the module bay. Fuses F3 and F4 control +/- 24 VDC power to JQR-3 and JQR-4 on the rear panel of the module bay.

The breaker labeled **AC OUTPUT** on the rear panel of the module bay is a 5 Amp breaker that switches 200-230 VAC power to the AC IEC C13 connectors on the front and rear panels. In order to turn on this power, push both sides of this breaker to the up position.
5.6 Shutoff Down the DynaCool System

If you will not be using the system for an extended period of time or you have to shut it down for maintenance such as power or water outages, or scroll-pump maintenance (Section 5.2.2), follow the procedures in Section 3.3.8.2 “Cryostat Control Tasks” to **Shut down** the system.

Once the system has shut itself down (8-16 hours), you may turn off the power to the cabinet.

---

5.7 Starting up a Cold DynaCool System

For starting up the system, see Section 3.2.8.2 “Cryostat Control Tasks” for the **Startup** procedure.

---

5.8 Compressor Adsorber Replacement

The adsorber in the compressor has to be replaced every 20,000 hours. Please refer to the “Routine Maintenance” section in the supplied Cryomech manual for detailed instructions on this procedure.

```
WARNING!

The cryocooler system can be seriously damaged if the required servicing is not performed. Other system components also should be serviced at the same time as the compressor.

Only qualified Quantum Design service personnel should perform maintenance work on the cryocooler. Contact your Quantum Design service representative to schedule maintenance on the cryocooler.
```

---

5.9 Cleaning

The outside surface of Dynacool should be periodically wiped down with a clean dry cloth. Use of cleaning agents, soaps, or solvents could damage the system and should be avoided.
5.10 Required Maintenance Log

The following maintenance procedures should be performed regularly. Some of the services must be performed by a qualified Quantum Design representative and you will need to schedule the maintenance visit with them. The cryocooler system can be seriously damaged if it is not serviced properly.

The maintenance logs on the following pages facilitate keeping track of what service has been performed. Make additional copies of the log pages as required.

Section 5.2 of this manual has instructions for services that you and other onsite personnel can perform.

Table 5-1. Maintenance procedures required for the DynaCool system.

<table>
<thead>
<tr>
<th>PART</th>
<th>SERVICE</th>
<th>FREQUENCY</th>
<th>WHO PERFORMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressor</td>
<td>Replace compressor adsorber</td>
<td>20,000 hours (2 years)</td>
<td>QD service personnel</td>
</tr>
<tr>
<td>Scroll pump</td>
<td>Replace tip seals</td>
<td>As required – see pump manual</td>
<td>Site personnel</td>
</tr>
</tbody>
</table>
## Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COMPRESSOR HOURS</th>
<th>WORK PERFORMED BY/AFFILIATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WORK COMPLETED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace compressor adsorber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace scroll-pump tip seals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Other (explain)</td>
</tr>
</tbody>
</table>

### COMMENTS

<table>
<thead>
<tr>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
# Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COMPRESSOR HOURS</th>
<th>WORK PERFORMED BY/AFFILIATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WORK COMPLETED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace compressor adsorber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace scroll-pump tip seals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Other (explain)</td>
</tr>
</tbody>
</table>

**COMMENTS**

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
## Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COM圧縮機</th>
<th>WORK PERFORMED BY/AFFILIATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WORK COMPLETED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace compressor adsorber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace scroll-pump tip seals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Other (explain)</td>
</tr>
</tbody>
</table>

### COMMENTS

---
---
---
---
---
---
---
## Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COMPRESSOR HOURS</th>
<th>WORK PERFORMED BY/AFFILIATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WORK COMPLETED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace compressor adsorber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace scroll-pump tip seals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Other (explain)</td>
</tr>
</tbody>
</table>

### COMMENTS

__________________________
__________________________
__________________________
__________________________
__________________________
__________________________
## Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COMPRSSOR HOURS</th>
<th>WORK PERFORMED BY/AFILIATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WORK COMPLETED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace compressor adsorber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace scroll-pump tip seals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Other (explain)</td>
</tr>
</tbody>
</table>

### COMMENTS

---
---
---
---
---
---
---
# Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COMPRESSOR HOURS</th>
<th>WORK PERFORMED BY/AFFILIATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WORK COMPLETED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace compressor adsorber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Replace scroll-pump tip seals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□ Other (explain)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COMMENTS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Quantum Design PPMS DynaCool User's Manual, 1307-110, Rev. D1 November 2017*
# Maintenance Log

<table>
<thead>
<tr>
<th>DATE</th>
<th>COMPRESSOR HOURS</th>
<th>WORK PERFORMED BY/AFFILIATION</th>
</tr>
</thead>
</table>

**WORK COMPLETED**

- □ Replace compressor adsorber
- □ Replace scroll-pump tip seals
- □ Other (explain)

**COMMENTS**

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
APPENDIX A

System Setup

A.1 Overview

This appendix contains instructions to physically install and set up DynaCool. Once you have completed the steps described in this appendix, refer to Section 1.4 to start up (also called cool down) the system.

A.2 Site Requirements

Before installing the DynaCool system, you should determine where to place the equipment. The pump cabinet and cryostat should be placed next to each other, preferably with the cabinet to the left of the cryostat as shown in Figure A-1. The floor space required for these two components is about 3 m wide by 2 m deep. The cabinet requires a single-phase 30 amp, 220 VAC 50/60 Hz power connection. Casters are provided on both the cabinet and cryostat, so moving the systems on a flat, hard floor is relatively easy.

![Diagram of pump cabinet and cryostat]

Figure A-1. Floor Space Requirement for Pump Cabinet and Cryostat
The compressor assembly must be located within about 30 m of the cryostat. While the compressor itself requires only about a 1 m square floor space, the stiff high-pressure helium lines have a large bending radius, and may require an additional 1 meter to make a 90-degree turn. The compressor requires cooling water and a 3-phase power connection.

The compressor is a fairly noisy piece of equipment compared to the rest of the instrument. Therefore you may wish to locate the compressor in a space that is separate from the DynaCool cabinet and cryostat. In this case, provision must be made to run the high-pressure helium lines between the compressor and the cryostat.

A.3 Initial Installation

Quantum Design service personnel will typically perform system set up. It is possible for you to set up the equipment yourself, so instructions are included here. Please read this section and contact Quantum Design service before attempting to set up the instrument.

Please refer to the DynaCool Installation Video for detailed installation instructions.

A.3.1 Unpack the Cryostat Crate

1. Remove the fasteners holding on the front side of the tall crate containing the cryostat. The front side of the crate forms the upper ramp section for rolling the cryostat out of the crate.
2. Remove the ramp and flip it around and place against the crate base to form the start of the ramp.
3. Locate the lower section of the ramp inside the crate (it may be screwed down and need to be removed) and complete the lower section of the ramp with this.
4. Inside the crate, remove the “foot” braces that prevent the cryostat from rolling around in the crate.
5. Remove the upper braces holding the top of the cryostat in the crate.
6. Raise the “landing pads” on the cryostat feet as high has they will go to allow clearance of the ramp while rolling out.
7. Carefully roll the cryostat down the ramp. At the top of the cryostat you can hold on to the heavy steal ring that encircles the cryostat top. Do not grab the aluminum brackets that stick up since these are fragile and must remain aligned for a later assembly step.
8. Remove the cryostat cover from the top of the crate and place in a safe location. You will install it later.
A.3.2 Unpack the Cabinet Crate

1. Remove the front and the top of the wider but slightly shorter crate containing the pump cabinet.
2. Remove the cables and small accessories from the space above the cabinet and set aside. Also remove the wood shelf that is on top of the pump cabinet.
3. Locate the ramp from the front of the cryostat cabinet and attach it to the front of the cabinet crate so the cabinet can roll down it. Complete the ramp with the short lower section of the ramp, also from the cryostat cabinet.
4. Roll the cabinet out of the crate and down the ramp.
5. Remove the CAN Module Bay and remaining parts from the crate.

A.3.3 Unpack and Inspect Fittings

1. Remove plastic from the cryostat and cut the ties holding the bundled cables stored on top of the cryostat.
2. Make sure none of the VCO-type fittings around the cryostat top-plate have come loose during shipping. There are seven of these in the area.
3. Connect the three flexible stainless hoses (in the black tether) from the cryostat to the VCO connections labeled “annulus,” “return,” and “chamber/case” on the side of the cabinet (See Figure 2-5). Tighten using wrench, 1/8-turn past finger-tight.
4. Remove the front and rear panels on the bottom of the cabinet and inspect all the VCO fittings to make sure none of them have come loose during shipping.

A.3.4 Connect Magnet Controller

1. Pull the upper front cover off the upper section of the pump cabinet to expose the magnet controller.
2. At the back of the cabinet, feed the magnet signal cable and the current leads through the back panel into the magnet controller bay. (See Figure 2-6.)
3. Attach the current leads to the magnet controller. The blue tape marks the current lead that connects to the positive (+) terminal on the controller.
4. Tighten the current leads securely using two wrenches.
5. Reattach the cover protecting the current-lead terminals.
6. Connect the magnet signal cable to the JQB-1 (Magnet Control) connector on the magnet controller.
7. Replace the front cabinet cover.

A.3.5 Make Cabinet Connections

Refer to Figure 2-6 and 2-7 for the following:

1. Remove cables and hardware from the computer bay at the back of the cabinet.
2. Attach the CAN terminator dongle to JQQ-3, CAN OUT. (Figure 2-7)
3. Attach cryostat valve and flow control cable to JQQ-6. (Figure 2-7)
4. Attach cryostat thermometer & heater control cable to JQQ2. (Figure 2-7)
5. Attach USB cable in the tether to the rear-facing port on the computer.
6. Attach the CAN network “IN” cable from the module bay to JQQ-4. (Figure 2-7)
7. Connect computer display and devices.

### A.3.6 Mount and Connect the CAN Module Bay

1. Remove the 4 thumb screws from side of the CAN module bay and carefully hang the bay on the mounting bracket on bracket at the right side of the cryostat. The two shoulder screws on the CAN module bay will engage the notches in the cryostat mounting bracket.

2. Attach the grounding strap from the cryostat shield to the CAN module bay using the first of the four thumbscrews. Use the upper-rear tapped hole for this. This thumbscrew also holds the module bay to the bracket.

3. Install the remaining three thumbscrews to secure the module bay.

4. At the back panel of the module bay, attach the cable from the magnet power supply to JQR-6. (Figure 2-4)

5. Attach the CAN cable from the cabinet to JQR-1. (Figure 2-4).

6. Attach USB cable from the computer to JQ5-5 (Figure 2-4).

7. Attach the CAN cable from the cryostat to JQR-2 (Figure 2-4).

8. Secure the cables at the back of the module bay using the Velcro strap.

9. Connect the magnet cable from the cryostat to JQR-7 (Figure 2-4).

10. Connect the 44-pin TCM cable from the cryostat to JG-1 at the temperature control module in the CAN Module Bay (Figure 2-3).

11. Connect power cable from outlet on cabinet (Figure 2-6) to CAN rack (Figure 2-4).

### A.3.7 Install Helium Gas Regulator

1. Unpack and install the helium regulator onto the helium cylinder. Use a wrench to tighten the connection.

2. Close the needle valve and open the bottle valve.

3. Use soapy water to leak-check the fitting.

4. Connect the helium supply hose to the double-sealing connector at the regulator using two wrenches.

5. Connect the other end of the helium supply hose to the VCO connection on the cabinet (Figure 2-5). Tighten using wrench, 1/8-turn past finger-tight.

6. Adjust regulator to about 15-20 psi (0.10-0.14 MPa) and open the needle valve.

### A.3.8 Make Compressor Connections

1. Refer to Cryomech instructions for connecting power and cooling water to the compressor unit.

2. Connect cold head power cable from the cryostat to the compressor (Figure 2-8).

3. Connect compressor control (RS232) cable to the 9-pin D-sub connector on the compressor (Figure 2-8) and connect the other end to the cabinet (Figure 2-7).
4. Connect the large helium hose from the “LOW” port on the compressor to the larger of the two helium connections at the back of the cryostat (Figure 2-2). Use the provided wrench for this.

5. Connect the helium hose from the “HIGH” port on the compressor to the smaller of the two helium connections at the back of the cryostat (Figure 2-2).

A.3.9 Power up the System

1. Turn on the breakers on the compressor.
2. Connect the cabinet power cord to wall power.
3. Turn on main and sub-system breakers on the back of the cabinet (Figure 2-6).
4. Turn on both the power switch and the spare breaker switch on the back of CAN module bay (Figure 2-4).

A.3.10 Attach Deck and Cryostat Cover

1. After positioning the cryostat, lower the feet into contact with the floor.
2. Locate mounting hardware for the deck.
3. Position deck on the feet of the cryostat.
4. Install mounting hardware on each of the feet. Tighten securely.
5. Carefully install the cryostat cover onto the top of the cryostat.
Appendix B

Diagnostic Software

B.1 Overview

This appendix describes diagnostic software operations that help you troubleshoot problems with your DynaCool instrument. Often you will use these features at the request of Quantum Design service personnel when you report a problem with the instrument. Data that you collect using these procedures can be sent to Quantum Design service to speed the diagnosis of your problem.

B.2 Log Data

The menu command “Utilities > Log Data…” is used to log diagnostic data for the instrument. To use the logger, click “Browse” and specify a file name where the data will be saved. You may specify a new file name or an existing log data file. Be careful: If you check the “Overwrite Existing File” box, any existing data in the file will be deleted! Also, specify how often to log data records to the file. Some problems are best diagnosed by very rapid data logging for a short period of time, while others are best diagnosed with very long logs with infrequent data records. A Quantum Design representative can usually help you determine the most appropriate logging interval to use when troubleshooting.

When you click “View Data,” the specified data file will be opened in a graph view. But no data will be present in the file until you select data items to log from the other three tabs—“Standard Items,” “Diagnostic Items,” and “Advanced Items”—and until you click “Start” (begins the logging) or “Acquire Once” (records all of the checked data items one time only.) Once logging, data will continue to be recorded to the file at the specified rate until you click “Stop.” You may change the data items being logged while the logger is running. A time stamp always accompanies each data record.
The menu command “Utilities > Sigma Log Data…” contains very similar capabilities to the log data command, except that you may log the statistics (average and standard deviation) of each data item as well. This generates data files that are significantly larger and more tedious to navigate than the standard log data command. The average values recorded with this command may be a simple average of all new data, or a running average of the last several data items, in which case each average may be calculated with some of the same data as the previous data record.

The following three sections describe the data available on the tabs of both the Log Data and Sigma Log Data dialogs.

**B.2.1 Standard Items**

The standard items tab contains information that is mostly available in the MultiVu status bar. The status of the chamber gas, temperature, magnetic field, and cryostat are recorded in the file as integers. The log data window displays the meaning of these status codes in real time, but this text is not included in the log data files. (Use “Utilities > Status Calculator…” to decode status codes. The “Query” button will decode the current state of the instrument.)

The ID numbers of the sample and control thermometers are also shown on this tab. These numbers tell you which thermometers are in use for special option temperature control modes. See Section 4.3.4 for details.
B.2.2  Diagnostic Items

The diagnostic items tab contains detailed information about the instrument state that is useful for troubleshooting. Problems with temperature control, magnetic field control, and the cryostat control can all be diagnosed using data in this tab.

B.2.3  Advanced Items

Advanced Items are all configurable data items. A large amount of raw instrument data is available for logging when required. Data can be logged from any CAN node on the bus. Configuration of these data items is accomplished with a map (*.qmap) file which is usually supplied by a Quantum Design representative. The map file is loaded using the “Select Map File” button and the resulting browse dialog.

B.3  Background Log

Any time MultiVu is running, it records diagnostic data to a background log file. The file (C:\QDDynaCool\MultiVu\BRLog.dat) is a normal MultiVu data file that can be viewed like any other data file. The background log file is limited in size to 20 MB. When this limit is reached, the file is copied to BRLog_bu.dat, and a new BRLog.dat file is created.
In case a problem occurs when you are not running Log Data, the problem might be diagnosed using the background log. Quantum Design personnel may ask you for this file if you report a problem with your instrument.

---

**B.4 Event and Error Logging**

Three types of text-based event and error logs exist on the DynaCool computer. Quantum Design Service may ask you for these files to help diagnose problems with your instrument.

**B.4.1 MultiVu Event Log**

The event log is a text file (C:\QDDynaCool\MultiVu\Event.log) containing diagnostic messages generated by the instrument, recorded with time stamps. The file is arranged chronologically with the most recent events at the end of the file.

The event log is limited to 10 MB in size. When this limit is reached, the file is copied to Event.log.bak and a new Event.log is created.

Events that require your immediate attention are displayed in dialogs by MultiVu. These events are also recorded in the event log along with less important events.

**B.4.2 Temperature, Magnet, and Cryostat Service Logs**

The Temperature, Magnet, and Cryostat Services all record details of their operation in a joint log file. Like the event log, this file is arranged chronologically with the most recent information at the end of the file.

The service logs are at C:\QDDynaCool\System\QdWapiLog_pg#.txt where # is a number from 1 to 10. The system starts recording information in file number 1, and continues writing to this file until its size exceeds 10 MB or the computer is restarted. At this point the system starts recording to file number 2, and so on. After using file number 10, the system goes back to file number 1. To determine which file is currently in use, you find the one with the most recent modified date. Typically Quantum Design Service will request all of these files if they are needed for problem diagnosis.

**B.4.3 Option Log Files**

Options typically write information to dedicated log files. See the appropriate option user manual for details.
APPENDIX C

Pin-out and Interconnect Diagrams

C.1 Overview

Sections C.2 - C.8 of appendix provide pin out and interconnection diagrams for DynaCool. Refer to option manuals for pin outs of option hardware, including option pucks and CAN modules.

Section C.9 describes how calibration data is stored in DynaCool SROMs.

C.2 System Interconnects

The diagrams below show how signals (Figure C-3 and C-4) and power (Figure C-5 and C-6) are routed in DynaCool. Refer to these diagrams if you are unsure where a cable should be connected.

The magnet controller model used in DynaCool depends on whether the system is equipped with a 9 T or 14 T magnet, so there are separate diagrams for each of these configurations.
Figure C-1. DynaCool System Interconnects for 9 T System
Appendix C
Pin-out and Interconnect Diagrams

Section C.2
System Interconnects

Figure C-2. DynaCool System Interconnects for 14 T System
Figure C-3. DynaCool Power Distribution for 9 T System
Figure C-4. DynaCool Power Distribution for 14 T System

*Voltage and frequency depend on compressor configuration
C.3 Sample Puck Connections (Gray Lemo and JQP-8)

The sample connector, which the puck mates with, is located at the bottom of the sample chamber. The sample gray Lemo connector is located on the right side of the cryostat enclosure above the CAN module bay. The sample D-shell connector is located under the cosmetic cryostat covers, at the top of the sample chamber on the right side when facing DynaCool from the front.

The connections labeled “Spare” are not wired to anything, but could be used to feed custom wires into the annulus.

![Sample connections diagram]

Figure C-5. Sample connections: a) Sample puck, b) Gray Lemo connector, c) JQP-8 Sample D-shell connector

Table C-1. Sample Puck Connections.

<table>
<thead>
<tr>
<th>SAMPLE PUCK</th>
<th>GRAY LEMO CONNECTOR</th>
<th>JQP-8 SAMPLE D-SHELL CONNECTOR</th>
<th>TYPICAL FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>8</td>
<td>Channel 1 I+</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>21</td>
<td>Channel 1 I-</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>9</td>
<td>Channel 1 V+</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>22</td>
<td>Channel 1 V-</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>10</td>
<td>Channel 2 I+</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>23</td>
<td>Channel 2 I-</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>5</td>
<td>Channel 2 V+</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>18</td>
<td>Channel 2 V-</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>6</td>
<td>Channel 3 I+</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>19</td>
<td>Channel 3 I-</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>7</td>
<td>Channel 3 V+</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>20</td>
<td>Channel 3 V-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>Spare A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14</td>
<td>Spare B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12</td>
<td>Spare C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25</td>
<td>Spare D</td>
</tr>
</tbody>
</table>
C.4 Temperature Control (JQP-9 and JG-1)

Connector JQP-9 is located on the sample chamber. It is under the cosmetic cryostat covers, at the top of the sample chamber on the left side when facing DynaCool from the front. Connector JG-1 is located on the temperature control module in the CAN module bay. Cable 3501-010 connects JQP-9 to JG-1.

The spare thermometer and heater are not connected to anything on the sample chamber. The “Serial Com” connections are used to read thermometer calibration data and other configuration information from the sample chamber SROM (see section C.9).

Figure C-6. Temperature control connections: a) JG-1 connector, b) JQP-9 connector
Table C-2. JQP-9 and JG-1 Temperature Control Connections

<table>
<thead>
<tr>
<th>JQP-9 CONNECTOR</th>
<th>JG-1 CONNECTOR</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Block Thermometer I+</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>Block Thermometer I-</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Block Thermometer V+</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>Block Thermometer V-</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Neck Thermometer I+</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>Neck Thermometer I-</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Neck Thermometer V+</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>Neck Thermometer V-</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>High Neck Thermometer I+</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>High Neck Thermometer I-</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>High Neck Thermometer V+</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>High Neck Thermometer V-</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>Spare Thermometer I+</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>Spare Thermometer I-</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>Spare Thermometer V+</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>Spare Thermometer V-</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>Spare Heater I+</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>Spare Heater I-</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>Neck Heater I+</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>Neck Heater I-</td>
</tr>
<tr>
<td>35</td>
<td>35</td>
<td>High Neck Heater I+</td>
</tr>
<tr>
<td>36</td>
<td>36</td>
<td>High Neck Heater I-</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>Block Heater I+</td>
</tr>
<tr>
<td>38</td>
<td>38</td>
<td>Block Heater I-</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>Serial Com Ground</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>Serial Com Data MISO</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>Serial Com Select</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>Serial Com +5 V</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>Serial Com Clock</td>
</tr>
<tr>
<td>44</td>
<td>44</td>
<td>Serial Com Data MOSI</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Shield</td>
</tr>
</tbody>
</table>
C.5 Cryostat Temperature Control (JQP-7 and JQQ-2)

Connector JQP-7 is located on the cryostat top plate. It is under the cosmetic cryostat covers, to the left of the top plate manifold when facing DynaCool from the front. Connector JQQ-2 is located on the back of the pump cabinet. Cable 3308-010 connects JQP-7 to JQQ-2.

Figure C-7. Cryostat temperature control connections: a) JQP-7 connector, b) JQQ-2 connector
Table C-3. JQP-7 and JQQ-2 Cryostat Temperature Control.

<table>
<thead>
<tr>
<th>JQP-7 CONNECTOR</th>
<th>JQQ-2 CONNECTOR</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>First Stage Thermometer I+</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>First Stage Thermometer I-</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>First Stage Thermometer V+</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>First Stage Thermometer V-</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Second Stage Thermometer I+</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>Second Stage Thermometer I-</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Second Stage Thermometer V+</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>Second Stage Thermometer V-</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>Magnet Thermometer I+</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>Magnet Thermometer I-</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>Magnet Thermometer V+</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>Magnet Thermometer V-</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>First Stage Heater I+</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>First Stage Heater I-</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>Second Stage Heater I+</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>Second Stage Heater I-</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>Cryopump Regeneration Heater I+</td>
</tr>
<tr>
<td>38</td>
<td>38</td>
<td>Cryopump Regeneration Heater I-</td>
</tr>
<tr>
<td>39</td>
<td>39</td>
<td>Impedance Heater I+</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>Impedance Heater I-</td>
</tr>
<tr>
<td>41</td>
<td>41</td>
<td>Pot Heater I+</td>
</tr>
<tr>
<td>42</td>
<td>42</td>
<td>Pot Heater I-</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>Serial Com Data</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>Serial Com +5 V</td>
</tr>
<tr>
<td>29</td>
<td>29</td>
<td>Serial Com Ground</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>Serial Com Clock</td>
</tr>
<tr>
<td>29</td>
<td>29</td>
<td>Shield</td>
</tr>
</tbody>
</table>

**C.6 Cryostat Gas Control (JQQ-6)**

Connector JQQ-6 is located on the back of the pump cabinet. The rest of the connectors are located under the cryostat cosmetic covers. The mass flow controller is on the right side of the cryostat when facing DynaCool from the front. JQP-10 is at the end of a short set of wires sticking out from left side of the top plate manifold. The high vacuum valve connector generally rests on the cryostat top plate behind the top plate manifold. Cable 3309-017 connects these components.
Figure C-8. Cryostat gas control connections: a) JQQ-6 connector, b) Mass Flow Controller connector, c) High Vacuum Valve connector, d) JQP-10 Solenoid Valve connector.

Table C-4. JQQ-6 Cryostat Gas Control.

<table>
<thead>
<tr>
<th>JQQ-6 CONNECTOR</th>
<th>MASS FLOW CONTROLLER</th>
<th>HIGH VACUUM VALVE</th>
<th>JQP-10 SOLENOID VALVES</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8</td>
<td></td>
<td></td>
<td>Mass Flow Controller Set Point (0-5 VDC)</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td></td>
<td></td>
<td>Mass Flow Controller Read Back (0-5 VDC)</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td>Mass Flow Controller Signal Common</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td></td>
<td></td>
<td>Mass Flow Controller +12 V/+15 V Supply</td>
</tr>
<tr>
<td>16</td>
<td>5</td>
<td></td>
<td></td>
<td>Mass Flow Controller Supply Common</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>Mass Flow Controller -15 V Supply (unused)</td>
</tr>
<tr>
<td>12</td>
<td>4</td>
<td></td>
<td></td>
<td>Case Solenoid Valve</td>
</tr>
<tr>
<td>24</td>
<td>2</td>
<td></td>
<td></td>
<td>Isolation Solenoid Valve</td>
</tr>
<tr>
<td>4</td>
<td>1,3</td>
<td></td>
<td></td>
<td>+24 VDC Relay Supply</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td>Spare 1 Solenoid Valve (unused)</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>Spare 2 Solenoid Valve (unused)</td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td></td>
<td></td>
<td>High Vacuum Valve Phase 1A</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
<td></td>
<td></td>
<td>High Vacuum Valve Phase 1B</td>
</tr>
<tr>
<td>21</td>
<td>3</td>
<td></td>
<td></td>
<td>High Vacuum Valve Phase 2A</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td></td>
<td></td>
<td>High Vacuum Valve Phase 2B</td>
</tr>
<tr>
<td>Shell</td>
<td></td>
<td></td>
<td></td>
<td>Shields</td>
</tr>
</tbody>
</table>
### C.7 Magnet Signals (JQP-4, JQR-6, JQR-7, JQR-8 and JQB-1/JQS-1)

Connector JQP-4 is located on the cryostat top plate, facing the rear of the cryostat. Connectors JQR-6, JQR-7, and JQR-8 are located on the back of the CAN module bay. JQB-1 (9T systems) or JQS-1 (14 T systems) is located on the back of the magnet controller. Cable 3309-016 connects JQP-4 to JQR-7. Cable 3308-011 connects JQR-6 to JQB-1 or JQS-1. Connections between JQR-6, JQR-7, and JQR-8 are made on a PC board inside the CAN module bay.

Many of the signals listed here are unused in DynaCool, but exist for possible future expansion. The modulation coil exists on some, but not all, DynaCool systems.

![Diagram](image)

Figure C-9. Magnet Signal connections: a) JQP-4 connector, b) JQR-6, JQR-7, and JQB-1/JQS-1 connector, c) JQR-8 connector.

<table>
<thead>
<tr>
<th>JQP-4 CONNECTOR</th>
<th>JQR-7 CONNECTOR</th>
<th>JQR-6 CONNECTOR</th>
<th>JQB-1 OR JQS-1 CONNECTOR</th>
<th>JQR-8 CONNECTOR</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td></td>
<td>Magnet V+</td>
</tr>
<tr>
<td>10</td>
<td>21</td>
<td>21</td>
<td>21</td>
<td></td>
<td>Magnet V-</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td></td>
<td>13</td>
<td></td>
<td>Modulation Coil I+</td>
</tr>
<tr>
<td>9</td>
<td>22</td>
<td></td>
<td>5</td>
<td></td>
<td>Modulation Coil I-</td>
</tr>
<tr>
<td>3</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td></td>
<td>Switch Heater I+ (unused)</td>
</tr>
<tr>
<td>8</td>
<td>23</td>
<td>23</td>
<td>23</td>
<td></td>
<td>Switch Heater I- (unused)</td>
</tr>
<tr>
<td>2</td>
<td>11</td>
<td>11</td>
<td>11</td>
<td></td>
<td>Quench Heater I+ (unused)</td>
</tr>
<tr>
<td>7</td>
<td>24</td>
<td>24</td>
<td>24</td>
<td></td>
<td>Quench Heater I- (unused)</td>
</tr>
<tr>
<td>1</td>
<td>25</td>
<td></td>
<td>12</td>
<td></td>
<td>Trim Coil I+ (unused)</td>
</tr>
<tr>
<td>6</td>
<td>13</td>
<td></td>
<td>4</td>
<td></td>
<td>Trim Coil I- (unused)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Shell</td>
<td>Shell</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Shell</td>
<td>Shield</td>
</tr>
</tbody>
</table>
C.8 QD CAN Connectors

There are several QD CAN connectors throughout DynaCool. All of these connectors share the pin-out shown in table C-6. QD CAN connector are either male or female 9-pin D-shell connectors as shown in Figure C-10. The +24 V, -24 V, and 24 V return connections are available on most but not all QD CAN connectors. QD CAN connectors include:

- JQR-1, JQR-2, JQR-3, and JQR-4 on the back of the CAN module bay
- JQR-9 on the front of the CAN module bay
- All female 9-pin D-shell connectors at the bottom of the module bay slots
- All male 9-pin D-shell connectors on the back panel of CAN modules
- JQQ-3 and JQQ-4 on the cryostat controller (located at the back of the pump cabinet)
- JQQ-7 inside the magnet controller bay of the pump cabinet
- JQB-4 or JQS-1 on the magnet controller (this designator refers to two connectors one female and one male)
- JQP-1 and JQP-2 on the utility module on the cryostat top plate

![QD CAN Connectors Diagram](image)

Figure C-10. QD CAN connectors: a) Male QD CAN connector, b) Female QD CAN connector

<table>
<thead>
<tr>
<th>PIN</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-24 VDC</td>
</tr>
<tr>
<td>9</td>
<td>+24 VDC</td>
</tr>
<tr>
<td>3</td>
<td>24 V Return</td>
</tr>
<tr>
<td>2</td>
<td>CAN Low</td>
</tr>
<tr>
<td>7</td>
<td>CAN High</td>
</tr>
<tr>
<td>6</td>
<td>System Ground</td>
</tr>
<tr>
<td>4</td>
<td>Sync Low</td>
</tr>
<tr>
<td>8</td>
<td>Sync High/Reset</td>
</tr>
<tr>
<td>5</td>
<td>Line Sync</td>
</tr>
</tbody>
</table>
C.9 Storage of Calibration Information (SROMs)

DynaCool calibration and configuration information is stored in serial EEPROM chips (SROMs) that are mounted to PC boards. The information stored in SROMs is read by CAN modules. In some cases the information is used directly by the CAN module that reads the SROM. In other cases the information is downloaded by software, which may use the information or upload it to another CAN module. Typically, an SROM is physically connected to the hardware described by the SROM information. As a result, it is not necessary to manipulate calibration files when replacing a component such as the sample chamber. Note that an SROM may be read by a CAN module that is physically far away from the SROM, but connected by a cable.

Table C-7 describes DynaCool SROMs, how they are read, and what component(s) use the information. This information may be helpful for troubleshooting, but is not needed for routine use of DynaCool. Table C-7 describes only DynaCool base-system SROMs. Options usually contain additional SROMs.
### Table C.7. DynaCool base system SROMs.

<table>
<thead>
<tr>
<th>SROM Name</th>
<th>SROM Location</th>
<th>CAN Module That Reads SROM</th>
<th>SROM to Module Connection</th>
<th>Information Stored on SROM and Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Control Module SROM#1</td>
<td>Temperature Control Module Main Board (3101-260)</td>
<td>Temperature Control Module (4101-260)</td>
<td>On-board</td>
<td>Temperature Control Module configuration</td>
</tr>
<tr>
<td>Temperature Control Module SROM#2</td>
<td>Sample Chamber Feedthrough Board (3309-311)</td>
<td>Temperature Control Module (4101-260)</td>
<td>Temperature Control Cable (3501-010)</td>
<td>Sample Chamber configuration and thermometer calibrations: used by TCM firmware.¹</td>
</tr>
<tr>
<td>Magnet Controller SROM#1</td>
<td>Magnet Controller Main Board (3503-050)</td>
<td>Hybrid Magnet Controller (9 T: 4503-010 14 T: 4308-700)</td>
<td>On-board</td>
<td>Magnet Controller calibration: used by magnet controller firmware</td>
</tr>
<tr>
<td>Cryostat Controller SROM#1</td>
<td>Cryostat Controller Board (3308-250)</td>
<td>Cryostat Controller (3308-250)</td>
<td>On-board</td>
<td>Pump Cabinet calibrations (pressure gauges and mass flow meter): used by Cryostat Controller Firmware.</td>
</tr>
<tr>
<td>Cryostat Controller SROM#2</td>
<td>Cryostat Feedthrough (3309-203)</td>
<td>Cryostat Controller (3308-250)</td>
<td>Cryostat Temperature Cable (3309-015)</td>
<td>Cryostat thermometer calibrations: used by Cryostat Controller firmware.² Magnet calibration: read by Magnet Service and uploaded to Magnet Controller. Used by Magnet Controller firmware.² Magnet safety temperatures: read and used by Magnet Service.² Temperature control configuration: read and used by Temperature Service.²</td>
</tr>
<tr>
<td>Utility Module SROM#1</td>
<td>Utility Module (3309-204)</td>
<td>Utility Module (3309-204)</td>
<td>On-board</td>
<td>Utility Module internal configuration</td>
</tr>
<tr>
<td>Utility Module SROM#2</td>
<td>Utility Module (3309-204)</td>
<td>Utility Module (3309-204)</td>
<td>16-pin square header</td>
<td>Level sensor calibration: used by Utility Module firmware. Level control configuration: read by Temperature Service and uploaded to Cryostat Controller.</td>
</tr>
</tbody>
</table>

¹ In case of failure to read Temperature Control Module SROM#2, sample chamber calibrations can be stored in Temperature Control Module SROM#1.

² In case of failure to read Cryostat Controller SROM#2, cryostat thermometer calibrations can be stored in Cryostat Controller SROM#1. Magnet calibration information can be stored in Magnet Controller SROM#1 or the file C:\QDDynaCool\Config\QDDynacool_MagnetEngine.ini. Magnet safety temperatures can be stored in C:\QDDynaCool\Config\QDDynacool_MagnetEngine.ini. Temperature control configurations can be stored in C:\QDDynaCool\QDDynacool_TempEngine.ini.
A P P E N D I X  D

Using Third-party Instruments

D.1  Overview

This chapter describes three ways to interface with DynaCool when using third-party instruments. You use one of these techniques when you want to use DynaCool to control temperature, magnetic field, and chamber atmosphere, but you perform the measurement using electronics and software not provided by Quantum Design. The techniques described below give you the ability to set and read temperature, magnetic field, and chamber state in order to automate this type of measurement.

In all cases, you control DynaCool by sending commands to MultiVu. You do not send commands directly to DynaCool hardware, because operation of the hardware is orchestrated by software services on the computer (see Sections 3.1 and 3.6). MultiVu provides an interface to send commands to these services (see Figure 3-1).

The sections describing techniques to control DynaCool are:

- **Section D.2** describes how you use **WinWrap® Visual Basic Scripting** to control DynaCool and third-party instruments.
- **Section D.3** describes how you use **National Instruments LabVIEW®** to control DynaCool.
- **Section D.4** describes how you use **Microsoft Object Linking and Embedding** to control DynaCool.

If you have questions about any of these techniques, email apps@qdusa.com.

D.2  WinWrap® Visual Basic Scripting in MultiVu

WinWrap is a Visual Basic Scripting development environment integrated into MultiVu. WinWrap uses the Visual Basic for Applications scripting language. You open the WinWrap environment using the MultiVu menu item “Sequence->Advanced->Edit Macro”. For more details about using WinWrap, read Application Note 1070-209, “Getting Started with Visual Basic Scripting in MultiVu” available on the Quantum Design website (http://www.qdusa.com). Example WinWrap macros are also available on the website using a link next to the application note.
Using WinWrap, you control DynaCool using MultiVu commands. You can control third-party instruments using GPIB with simple MultiVu commands. Note that no GPIB controller is provided with DynaCool, so you need to provide one. Quantum Design recommends using a USB GPIB controller from National Instruments for this purpose.

For advanced users, controlling instruments that use other communication technologies is possible by making OLE or COM calls from WinWrap to external libraries.

---

D.3 National Instruments LabVIEW®

Quantum Design provides LabVIEW Virtual Instruments (VIs) for control of DynaCool from LabVIEW. Using these VIs and the associated dll and server, it is possible to control MultiVu from LabVIEW in two ways:

- LabVIEW on the same computer as MultiVu. This requires installation of LabVIEW on the MultiVu computer.
- LabVIEW on a separate computer, communicating with the MultiVu computer over a Local Area Network connection. A server runs on the MultiVu computer in this configuration, and you can use LabVIEW computers that you have already set up. This configuration may save licensing costs and allows you to use one LabVIEW station with different instruments.

For more information about this technique, consult the Application Note 1070-210, “Interfacing LabVIEW Programs with Quantum Design Instruments,” available on the Quantum Design website (http://www.qdusa.com).

Quantum Design’s support of LabVIEW is limited to the VIs controlling the Quantum Design instrument. Quantum Design does not provide LabVIEW software itself or support controlling third-party instruments using LabVIEW. Many third-party instrument providers supply LabVIEW VIs to allow you control their instruments from LabVIEW. See the National Instruments website for information about LabVIEW: http://www.ni.com/labview/.

---

D.4 Object Linking and Embedding (ActiveX)

MultiVu acts as an Object Linking and Embedding (OLE) server, so it can be controlled from any program or programming language that can act as an OLE client. Examples include Microsoft Excel, all Microsoft Visual Studio® languages (such Visual Basic, C++, and C#) as well as Embarcadero Delphi® (formerly known as Borland Delphi). If you are a capable programmer and want to control third-party instruments from your programming language of choice, you may want to use this technique. This technique is for advanced users only, and Quantum Design does not support any of the third-party development environments that you would use to implement an OLE client.

Note that the techniques described in the above sections use OLE “under the hood” to communicate with MultiVu.

You establish an OLE connection with MultiVu in one of two ways:
• **Early Binding**. With early binding the OLE client knows details of the OLE methods supplied by the MultiVu OLE server at compile time, so you may get syntax checking and code completion for the OLE methods in your development environment. To use early binding, point your development environment at the type library C:\QDDynacool\Dynacool.tlb.

• **Late Binding**. With late binding the OLE client does not know details about the OLE methods supplied by MultiVu. However, late binding is more reliable than early binding in some programming environments, and is typically less version-dependent. To use late binding, refer to MultiVu using the Class ID "QD.MULTIVU.DYNACOOL.1".

Many OLE methods are available in MultiVu. Most of these methods are for use by Quantum Design software only, not end users. Use only the following OLE methods:

• SetTemperature: Set the temperature, rate, and approach mode.

• GetTemperature: Read the present temperature and temperature status.

• SetField: Set the magnetic field, rate, approach mode, and end mode.

• GetField: Get the present magnetic field and field status.

• SetChamber: Set the chamber state (purge, seal, high vacuum, etc.)

• GetChamber: Get the current chamber state.

Here are some resources for learning about how to use the available OLE methods:

• **Example WinWrap macros and associated documentation**. Example WinWrap macros are available on the Quantum Design website (http://www.qdusa.com) in a link next to Application Note 1070-209, “Getting Started with Visual Basic Scripting in MultiVu”. You can learn how to use the OLE interface by examining these example macros. Also, included with the macros is the file MultiVu_OLE_Dictionary.pdf that contains descriptions of the OLE methods.

• **Example WinWrap macros**. Example WinWrap macros are available on the Quantum Design website (http://www.qdusa.com) in a link next to Application Note 1070-209, “Getting Started with Visual Basic Scripting in MultiVu”. In these macros, look at calls of the form “MultiVu.Method(arguments)” to learn how to use MultiVu OLE methods.

• **View the type library**. If your development environment includes a type library viewer, you can view method signatures in the type library C:\QDDynacool\Dynacool.tlb.